Pro Tools
TDM Hardware Installation Guide
Version 5.0 for Macintosh and Windows
Chapter 1. Pro Tools TDM System Requirements ............................................. 1
  System Requirements ............................................................................. 1
  Additional Requirements for Blue & White G3 Macintosh Computers .......... 3
  Audio Requirements ............................................................................. 4
  Compatibility Information ...................................................................... 4

Chapter 2. Installing Pro Tools Hardware .................................................... 5
  The Pro Tools Cards .............................................................................. 5
  Installing the Pro Tools Cards ................................................................. 8
  Connecting an Audio Interface ............................................................... 11

Chapter 3. Connecting SCSI Drives ............................................................. 15
  Audio Storage Guidelines ..................................................................... 15
  SCSI Requirements .............................................................................. 15
  Formatting Drives for Macintosh-based Systems .................................... 16
  Formatting Drives for Windows-based Systems ....................................... 16
  Improving System Performance ............................................................ 17
  Connecting SCSI Drives to Pro Tools MIX and Pro Tools 24 Systems ...... 18
  Connecting SCSI Drives To Pro Tools III Systems .................................. 19
  Preparing SCSI Drives on Windows-based Systems ............................... 20
  Using Macintosh Drives on Windows Systems ....................................... 22
  Using The Mt. Digi Utility ...................................................................... 23

Chapter 4. Connecting Your Studio ............................................................. 25
  Choosing an Output Mode ...................................................................... 25
  The 888/24 I/O Interface ...................................................................... 26
  Changing Operating Levels of Individual 888/24 I/O Channels ............... 30
  Making Signal Connections to the 888/24 I/O ....................................... 32
  Using the 888/24 I/O Interface as Stand-Alone Audio Converter ............ 33
The 882/20 I/O Interface ............................................................... 34
Making Signal Connections to the 882/20 I/O .......................... 38
Using the 882/20 I/O Interface as Stand-Alone Audio Converter ... 39
The 1622 I/O Interface ............................................................. 40
Making Signal Connections to the 1622 I/O Interface ............... 43
Using the 1622 I/O Interface as Stand-Alone Audio Converter ... 45
Connecting Equipment with Digital Audio Ins and Outs .......... 46
Connecting Effects Units .......................................................... 46
MIDI Connections ...................................................................... 47
Connecting SMPTE Synchronization Devices ......................... 48

Chapter 5. Making Sure Your System Is Working ......................... 51
Configuring Expanded Pro Tools Systems ............................... 51
Starting Up Your System ........................................................... 52
Installing the Demo Session ......................................................... 52
Opening the Demo Session .......................................................... 53
Choosing an Output Mode ............................................................ 54

Appendix A. Determining Slot Order On Macintosh Computers .... 57
Card Order Guidelines for Each Pro Tools System ................. 57

Appendix B. Calibrating the 888/24 I/O ....................................... 59
About Calibration ........................................................................ 59
Calibrating The 888/24 I/O .......................................................... 60

Appendix C. Hard Drive Maintenance .......................................... 63
Tuning Up Hard Drives ............................................................... 63
Using Iomega Jaz Drives ............................................................. 65

Index ......................................................................................... 69
chapter 1

Pro Tools TDM System Requirements

Pro Tools software runs on a variety of TDM system hardware configurations including:

Pro Tools 24 MIX™/MIXplus™ Include a Pro Tools MIX card (two MIX cards in the case of a MIXplus system), and your choice of the 888/24 I/O, 882/20 I/O, 1622 I/O, or ADAT Bridge I/O. A core system provides:
• Up to 64 tracks of recording/playback of 24-bit and 16-bit audio files
• TDM digital mixing and DSP Plug-In environment
• Non-linear, random-access editing and mix automation
• MIDI recording, playback and editing

Pro Tools 24™ Includes a d24 audio card, a DSP Farm, and your choice of the 888/24 I/O, 882/20 I/O, 1622 I/O, or ADAT Bridge I/O. A core system provides:
• Up to 32 tracks of recording/playback of 24-bit and 16-bit audio files
• TDM digital mixing and DSP Plug-In environment
• Non-linear, random-access editing and mix automation
• MIDI recording, playback and editing

Pro Tools III™ Includes a Disk I/O card, a DSP Farm, and your choice of the 888/24 I/O or 882/20 I/O. A core system provides:
• 16 tracks of recording/playback of 16-bit audio files.
• TDM digital mixing and DSP Plug-In environment
• Non-linear, random-access editing and mix automation
• MIDI recording, playback and editing

System Requirements

The CPU, hard disk, monitoring and MIDI requirements for Pro Tools differ depending your system configuration and computer platform (Macintosh or Windows). The requirements for each configuration are listed below.

CPU Requirements

Macintosh
• A Digidesign-qualified, PCI-based Power Macintosh computer with:
  • At least 128 MB RAM. For 64-voice performance, 192 MB of RAM is required
Pro Tools TDM Hardware Installation Guide

- Additional RAM is highly recommended if you plan to use other audio or MIDI applications concurrently with Pro Tools. Virtual memory is not supported.
- Apple System software version 8.6 or higher.
- Apple QuickTime System Extension version 4.0 or higher (included with Pro Tools)
- OMS (Open Music System) software (included with Pro Tools)
- A 17-inch or larger color monitor. Black and white monitors are not supported.

Windows NT
- A Digidesign-qualified, uniprocessor Pentium II or Pentium III-based computer running at 233 MHz or faster:
  - At least 192 MB of RAM. For 64-voice performance, 256 MB of RAM is required.
  - 1 unused PCI slot for Pro Tools 24 MIX systems. 2 unused adjacent PCI slots for Pro Tools 24 or Pro Tools 24 MIXplus systems. Expanded systems require additional unused adjacent PCI slots or an expansion chassis.
  - Intel 440LX or 440BX chip set
  - Phoenix or Award BIOS
  - a CD-ROM drive
  - an AGP display card is strongly recommended
- Windows NT, Workstation Edition, version 4.0 with Service Pack 4 or higher.
- A 17-inch or larger color monitor. Black and white monitors are not supported.

Hard Drive Requirements

Macintosh

Pro Tools 24 MIX and MIXplus Require one or more Digidesign-approved SCSI drives attached to a qualified PCI SCSI accelerator card for audio recording and storage. For best 64-track, 24-bit performance, use at least 4 hard drives, with audio files distributed among them.

Pro Tools 24 Requires one or more Digidesign-approved SCSI drives attached to the internal or external Macintosh SCSI chain or a qualified PCI SCSI accelerator card for audio recording and storage. For best 32-track, 24-bit performance, use at least 2 hard drives, with audio files distributed among them.

Pro Tools III Requires one or more Digidesign-approved external SCSI drives attached to the Pro Tools Disk I/O for audio recording and storage. An external SCSI drive cannot be used as a Startup drive.

Windows

Pro Tools 24 MIX and MIXplus Require one or more Digidesign-approved SCSI drives attached to a qualified PCI SCSI accelerator card or the embedded SCSI connector on the motherboard for audio recording and storage. For best 64-track, 24-bit performance, use at least 4 hard drives, with audio files distributed among them.

Pro Tools 24 systems Require one or more Digidesign-approved SCSI drives attached to a qualified PCI SCSI accelerator card or embedded SCSI connector on the motherboard for audio recording and storage. For best 32-track, 24-bit performance, use at
least 2 hard drives, with audio files distributed among them.

▲ EIDE drives are not supported for use as audio drives on Windows-based Pro Tools systems. If you wish to use an EIDE drive as a system drive, or an IDE based CD-ROM drive, the Intel PIIX IDE driver for Windows NT 4.0 is required. This driver is provided on the Pro Tools Installer CD-ROM. See the Pro Tools Software Installation Guide for details.

▲ If you are using an Expansion Chassis with a Windows-based Pro Tools system, IDE drives and drivers must be removed from your system. For more information, see the Pro Tools Expanded System Installation Guide.

### MIDI Requirements

**Macintosh**
- OMS software (included with Pro Tools)
- A Macintosh-compatible MIDI Interface
- A MIDI controller and/or sound modules

**Windows**
- A Windows-compatible MIDI Interface
- A MIDI controller and/or sound modules

### Additional Requirements for Blue & White G3 Macintosh Computers

The Apple Power Macintosh G3, also known as the Blue & White G3, requires additional hardware to run Pro Tools. The requirements are given below for each type of Pro Tools system.

**Pro Tools 24 MIX/MIXplus and Pro Tools 24**

**External Diskette Drive** A qualified floppy drive, along with the appropriate driver software (included on the Pro Tools Installer CD-ROM), is required to authorize Pro Tools software and Digidesign Plug-Ins.

**SCSI Accelerator card** A qualified SCSI Accelerator card is required to connect audio drives to Blue & White G3 computers.

**ATA system drive** Pro Tools requires the standard ATA system drive and not the optional Apple SCSI drive for Blue & White G3 computers.

**Pro Tools III**

**External Diskette Drive** A qualified floppy drive, along with the appropriate driver software (included on the Pro Tools Installer CD-ROM), is required to authorize Pro Tools software.

**ATA system drive** Pro Tools requires the standard ATA system drive and not the optional Apple SCSI drive for Blue & White G3 computers.

### MIDI Connectivity

To use a MIDI Interface with Pro Tools on the Blue & White G3, the interface must be USB compatible. Alternatively, you can use a card such as the Griffin Technologies gPort™ which connects to the internal modem port and provides a serial port connection suitable for most MIDI applications.
USD Connectivity
To use a Digidesign Universal Slave Driver with the Blue & White G3, it must be connected to the DigiSerial port on a Digidesign card. Only Pro Tools 24 and Pro Tools 24 MIX/MIXplus systems have DigiSerial ports.

MachineControl
To use MachineControl with the Blue & White G3, use the DigiSerial port on the Pro Tools d24 or MIX card, or add a qualified external USB-to-Serial port converter to use the Apple USB port on the computer.

Audio Requirements
To record and play audio you must have:
• An audio amplifier and speakers, or self-powered speakers
• Optionally, a mixing console and sound source. Depending on which system and Audio Interface you are using, this device must be equipped with the appropriate connections. The connections and operating levels for Digidesign Audio Interfaces are as follows:

888/24 I/O
• Analog: XLR (balanced or unbalanced) connectors, +4 dBu or –10 dBV
• Digital: XLR (AES/EBU) or RCA (S/PDIF) connectors

882/20 I/O
• Analog: 1/4” TRS (balanced or unbalanced) connectors, +4 dBu or –10 dBV
• Digital: RCA (S/PDIF) connectors

1622 I/O
• Analog: 1/4” TRS (balanced or unbalanced) connectors. Inputs are variable from +4 dBu to –10 dBV; outputs are selectable between +4 dBu or –10 dBV.
• Digital: RCA (S/PDIF) connectors

Digidesign ADAT Bridge I/O
• Analog: 1/4” TRS (balanced) connectors, +4 dBu or –10 dBV
• Digital: XLR (AES/EBU) or RCA (S/PDIF) connectors
• Optical: Two pairs of EIAJ fiber optic connectors

Compatibility Information
Digidesign can only assure compatibility and provide support for devices it has tested and approved.

For a list of qualified computers, diskette drives, SCSI accelerators, serial port converters and hard drives, refer to the latest Digidesign compatibility documents, available from Digidesign by fax or on the Digidesign website.

See the title page of this guide for Digidesign’s contact information.
chapter 2

Installing Pro Tools Hardware

The order in which you install Pro Tools software and hardware depends on which computer platform you are using.

Macintosh

On Macintosh systems, install Pro Tools software first, so you can use the DigiTest utility to determine proper card order in your computer. Refer to the Pro Tools Software Installation Guide before installing Pro Tools hardware. Finish by installing Pro Tools hardware.

Windows NT

On Windows NT systems, run the Install-O-Rator utility first, to configure your system to properly recognize Pro Tools hardware. Refer to the Pro Tools Software Installation Guide before installing Pro Tools hardware. Install Pro Tools hardware next, and finish by installing Pro Tools software.

Expanded Pro Tools Systems

If you are installing an expanded system in your computer, or using an Expansion Chassis to add additional cards to your system, refer to the Expanded System Installation Guide included with your Pro Tools system.

The Pro Tools Cards

Your Pro Tools cards will differ depending on your system configuration. Card components for each configuration are listed below.

Pro Tools 24 MIX Hardware

Pro Tools 24 MIX hardware comes in two configurations:

Pro Tools 24 MIX Includes a single MIX Core card and a 5-node TDM ribbon cable for connecting it with other optional TDM-equipped cards.

Pro Tools 24 MIXplus Includes a MIX Core card, a MIX Farm card, and a 5-node TDM ribbon cable for connecting the MIX Core to the MIX Farm and other optional TDM-equipped cards.
The MIX Core Card

The MIX Core card provides 24-bit, 64-track, 16-channel I/O, direct-to-disk recording and playback to your Pro Tools 24 MIX system, as well as DSP power for its mixing and processing capabilities.

This card includes a connector for attaching a single 888/24 I/O, 882/20 I/O, or 1622 I/O Audio Interface. If you purchase the optional 16-channel peripheral cable adapter, you can attach two 8-channel Audio Interfaces. The DigiSerial port is for connecting a Digidesign Universal Slave Driver, or a 9-pin device for use with the Pro Tools MachineControl option.

The MIX Farm Card

The MIX Farm card provides more DSP power for mixing, processing, and DSP software such as the DigiRack Plug-Ins included with Pro Tools. It also provides a connector for attaching a single 888/24 I/O, 882/20 I/O, or 1622 I/O Audio Interface. If you purchase the optional 16-channel peripheral cable adapter, you can attach two 8-channel Audio Interfaces.

Pro Tools 24 Hardware

Pro Tools 24 Core System hardware consists of a d24 audio card, a DSP Farm card, and a 5-node TDM ribbon cable for connecting them together.

The d24 Audio Card

The d24 audio card provides 24-bit, 32-track, 16-channel I/O, direct-to-disk recording and playback capabilities to your Pro Tools 24 system. It also provides a connector for attaching a single 888/24 I/O, 882/20 I/O, or 1622 I/O Audio Interface. If you purchase the optional 16-channel peripheral cable adapter, you can attach two 8-channel Audio Interfaces.

The DigiSerial port is for connecting an optional Digidesign Universal Slave Driver, or a 9-pin device for use with the Pro Tools MachineControl option.
The DSP Farm

The DSP Farm provides the power for the Pro Tools 24 system's mixing and processing capabilities. It powers DSP software such as the DigiRack Plug-Ins included with Pro Tools. It also provides a connector for attaching an 8-channel Audio Interface.

The 1622 I/O Audio Interface is not supported by the DSP Farm. It must be connected to a MIX Core, MIX Farm, or d24 card. Only one 1622 I/O can be connected to any of these cards. The optional 16-channel peripheral cable adapter is not supported by the 1622 I/O.

Pro Tools III Hardware

A Pro Tools III Core System consists of a Disk I/O card, a DSP Farm card, a 5-node TDM cable for connecting the two, and a custom SCSI cable for connecting SCSI drives directly to the Disk I/O card.

The Disk I/O Card

The Disk I/O card provides the 16-bit, 16-track, 8-channel I/O, direct-to-disk recording and playback capabilities of your system. It also provides a connector for attaching a SCSI hard drive and an I/O connector for attaching an 8-channel Audio Interface.

The TDM Ribbon Cable

The TDM ribbon cable is used to connect multiple cards in your Pro Tools system so they can share data along the TDM Bus.

TDM Ribbon Cable

A 5-node cable comes with your system. If you plan to use your system with an expansion chassis, you can order a TDM cable with more nodes from your Digidesign dealer.
Installing the Pro Tools Cards

The first step in your hardware installation is installing the Pro Tools cards.

Macintosh Systems

On Macintosh systems, Pro Tools cards must be installed in a specific order that is dependent on the slot numbering of the model of Macintosh you are using.

See Appendix A: Determining Slot Order On Macintosh Computers for details on determining slot order in your system.

To install the Pro Tools cards:

1. Turn off your computer. Leave it plugged in so that it is grounded.
2. Open the computer case. The illustrations in this section show a Blue & White Macintosh G3 and a Macintosh 9600 computer. If you are using a different model, your installation should be similar. For additional details on installing a card in your computer, refer to its User’s Guide.
3. Before handling any card, discharge any static electricity that may be on your clothes or body by touching a grounded metal surface, such as the power supply case inside your computer.
4. Remove the metal access port cover behind the expansion slot you wish to use by removing the screw (if present) and sliding the cover out from the access port.
5. Unpack any additional Pro Tools cards and remove their antistatic bags, observing the same precautions as before.
6. Plug the additional cards into subsequent slots beginning with the slot adjacent to...
the primary Pro Tools card. Group similar cards together (put all MIX Farm cards next to each other, for example).

7. Connect all TDM-equipped cards with the TDM ribbon cable.

Connect the first node of the cable to the first card, then attach the remaining nodes on the cable to subsequent cards.

There are white triangles on the plugs of the TDM ribbon cable and on your Pro Tools cards. Match these triangles to make sure the TDM ribbon cable is turned the right direction.

Push down gently but firmly until the node is fully connected to the card. When the plug is properly seated, the two tabs on the side of the cable's TDM connector will click shut. To detach the ribbon cable, squeeze the tabs on the TDM connector inward.

* It is OK to have ribbon connectors that go unused. They should reside after the last TDM-equipped card.

---

**Windows Systems**

**To install the Pro Tools cards:**

1. Make sure your computer is turned off. Leave it plugged in so that it is grounded.

2. Remove the computer's cover. The illustration depicts installation in a standard 4-slot, ATX motherboard-based PCI computer. Your installation should be very similar.

3. Look at the available PCI slots in the computer. Pro Tools 24 MIXplus and Pro Tools 24-based systems require a minimum of two adjacent PCI slots. These two adjacent slots should be located closest to the AGP port or power supply of the computer.

4. Before handling any card, discharge any static electricity that may be on your clothes or body by touching a grounded metal surface, such as the power supply case inside your computer.

5. If you already have one or more PCI cards (such as a modem or SCSI accelerator) in either of the two slots closest to the power supply, remove the rear-panel screw that holds each card in place and place the cards in the slots farthest away from the power supply to make room for the Pro Tools cards.

5. After reordering your existing PCI cards, restart your computer and make sure that the cards are still recognized in their new slot locations. The best way to do this is to watch for error messages during startup and to open and use any software which accesses the cards to confirm proper operation.
6 If the cards are recognized, shut down your computer, secure the cards with the screws you removed earlier, and proceed with the Pro Tools card installation.

7 Remove the metal access port cover behind the expansion slots you wish to use by removing the screw and sliding the cover out from the access port.

8 Remove the MIX Core or d24 card from its protective antistatic bag. Align the card with the appropriate expansion slot and push the card into the PCI connector until it is fully inserted in the slot. Avoid flexing the card or putting undue pressure on your computer’s motherboard.

9 If you have a Pro Tools 24 MIXplus system, unpack the MIX Farm card and remove it from its antistatic bag, observing the same precautions as before.

10 Plug the MIX Farm card into the PCI slot adjacent to your MIX Core card. If you have additional MIX Farm, DSP Farm, or MIX I/O cards, install them in subsequent slots. Group similar cards together (put all MIX Farm cards next to each other, for example).

11 Connect all TDM-equipped cards with the TDM ribbon cable.

Connect the first node of the cable to the first card, and attach the remaining nodes on the cable to subsequent cards.

There are white triangles on the plugs of the TDM ribbon cable and on your Pro Tools cards. Match these triangles to make sure the TDM ribbon cable is turned the right direction.

Push down gently but firmly until the node is fully connected to the card. When the plug is properly seated, the two tabs on the side of the cable’s TDM connector will click shut. To detach the ribbon cable, squeeze the tabs on the TDM connector inward.

* It is OK to have ribbon connectors that go unused. They should reside after the last TDM-equipped card.

12 Secure the cards in place with the slot access port screws you removed earlier and close your computer.
Connecting an Audio Interface

Pro Tools provides you with a choice of the 888/24 I/O, 882/20 I/O, 1622 I/O, or ADAT Bridge I/O Interfaces. These devices supply the inputs and outputs for your system.

For instructions on connecting an ADAT Bridge I/O, see the ADAT Bridge I/O Installation Guide.

The appropriate I/O peripheral cable for connecting an Audio Interface to your Pro Tools card is included with your Audio Interface. If you wish to connect a second Audio Interface to a MIX or d24 card, you can purchase the optional 16-channel peripheral cable adapter from your authorized Digidesign reseller.

* The 1622 I/O is a 16-channel audio interface. Its supplied cable carries all 16 channels, and does not require an adapter.

Using Multiple Pro Tools Cards and Interfaces

If you have multiple Pro Tools cards and Audio Interfaces, the Audio Interface that you want to function as clock master for your system must be connected to your core Pro Tools card.

On Macintosh computers, the core Pro Tools card is the card in the lowest-numbered PCI slot inside the CPU—typically the one nearest the computer’s power supply. (Subsequent PCI slots are numbered sequentially in ascending order.)

On Intel-based computers, PCI slots are not numbered sequentially according to their physical location inside the CPU. For this reason, you must launch the DigiTest utility before running Pro Tools to determine the slot numbering for installed cards.

For more information on using DigiTest to confirm card/slot order, see “Configuring Expanded Pro Tools Systems” on page 51.

To connect the Audio Interface:

1. Carefully unpack the Audio Interface. Depending on how your studio is set up, you may wish to make audio and power connections before you mount the Audio Interface in your rack.
2 If you are using two or more Audio Interfaces with your Pro Tools system, connect them together at the Slave Clock In/Out ports using the enclosed BNC cables as shown in the illustration that follows.

The “master” Audio Interface should be connected to the core Pro Tools card. On Macintosh computer’s this is typically the card nearest the computer’s power supply. If you connect two Audio Interfaces to a MIX Core or d24 card using the optional 16-channel peripheral cable adapter, the master interface is the one connected to the cable labeled “Interface A.”

3 Connect the interface cable to your core Pro Tools card as shown in the illustrations. Gently push the cable’s connector into the card’s interface port and secure the connector in place with its thumbscrews.

4 If you have two 8-channel Audio Interfaces and wish to connect both of them to a MIX Core or d24 card, you may do so by purchasing Digidesign’s 16-channel peripheral cable adapter. Connect the single end of the Y-cable to the MIX Core or d24 card as shown in the illustration that follows. Gently push the cable’s connector into the card’s interface port and secure the connector in place with its thumbscrews.
Because the 1622 I/O is a 16-channel device, it uses all 16-channels of I/O on a Pro Tools MIX or d24 card. A second interface cannot be connected.

5 Connect the other ends of the Y-cable to the Audio Interface cables. (The Y portion of the cable is labeled “Interface A” and “Interface B” for reference.)

6 Connect the Audio Interface cable to the back of the Audio Interface. (If you have two interfaces and the optional 16-channel peripheral cable adapter, connect each cable to an interface.) To do this, pinch the tabs on either side of the connector and push it into the port labeled “Computer” on the rear of the Audio Interface. Release pressure on the metal tab to lock the connector into place.
7 If you have additional Audio Interfaces and Pro Tools cards, connect the Audio Interfaces to corresponding cards with the interface cables.

⚠️ The 1622 I/O Audio Interface is not supported by the DSP Farm. It must be connected to a MIX Core, MIX Farm, or d24 card.

If you are connecting both 888/24 and 882/20 or 1622 I/O Audio Interfaces to your system, for best system performance, connect the 888/24 to your core Pro Tools card, followed by any additional 888/24 Interfaces to the next highest-priority cards. Then connect the 882/20 or 1622 I/O interfaces to subsequent cards.

‼️ If you have an ADAT Bridge I/O, see the ADAT Bridge I/O Installation Guide for special installation guidelines.

8 Connect the power cable to the rear of each Audio Interface. The Audio Interface automatically selects the power setting for use with the standard voltage and frequency in any country. Simply connect the power cable appropriate to your local power standard and the Audio Interface will function normally.
Pro Tools is a disk-based recording system. As such, SCSI hard drives function as the recording media and it is there that Pro Tools sessions and audio files are kept.

Audio Storage Guidelines

Audio tracks recorded at 24-bit resolution at a CD-fidelity sampling rate of 44.1 kHz require about 7.5 MB of hard disk space per minute. The same tracks recorded at 16-bit resolution require about 5 MB per minute.

Using these guidelines:
- 64 tracks of 24-bit audio takes up about 480 MB of hard disk space per minute.
- 64 tracks of 16-bit audio takes up about 320 MB of hard disk space per minute.
- 32 tracks of 24-bit audio takes up about 240 MB of hard disk space per minute.
- 32 tracks of 16-bit audio takes up about 160 MB per minute.

A 9-gigabyte drive holds:
- 18 minutes of 64 track, 24-bit audio
- 28 minutes of 64 track, 16-bit audio
- 37 minutes of 32 track, 24-bit audio
- 56 minutes of 32 track, 16-bit audio

Digidesign can guarantee optimum and reliable performance only when Digidesign-qualified hard drives and SCSI accelerators are used. Contact your Digidesign dealer or visit Digidesign's website for a list of approved hard drives and SCSI accelerator cards.

SCSI Requirements

Each Pro Tools configuration has specific SCSI requirements:

Pro Tools 24 MIX and MIXplus These systems require one or more Digidesign-approved SCSI drives attached to a qualified PCI SCSI accelerator card, or on Macintosh computers, the internal or external Macintosh SCSI chain. For best 64-track, 24-bit performance, use at least 4 hard drives, with audio files distributed among them.

Pro Tools 24 These systems require one or more Digidesign-approved SCSI drives attached to a qualified PCI SCSI accelerator card, or on Macintosh computers, the internal or external Macintosh SCSI chain. For best 32-track, 24-bit performance, use at least 2 hard drives, with audio files distributed among them.
Pro Tools III

These systems require one or more Digidesign-approved external SCSI drives attached to the Pro Tools Disk I/O card for audio recording and storage. A drive connected to the Disk I/O cannot be used as a Startup drive.

SCSI on Power Macintosh Computers

All Macintosh G3 computers currently require a SCSI accelerator for use with Pro Tools.

Some older Power Macintosh models such as the 9600 have two SCSI busses: an internal fast SCSI bus and an external slow SCSI bus. Each bus allows you to connect up to 7 SCSI devices. For optimum Pro Tools performance (without a SCSI accelerator), use the internal/fast SCSI bus.

While the internal and external SCSI busses on older Power Macintosh models yield reasonable performance on sessions with low track counts, a SCSI accelerator card is required on sessions with high track counts and high edit density.

Formatting Drives for Macintosh-based Systems

SCSI hard drives used for audio recording on Pro Tools for Macintosh systems must be formatted for either the HFS or HFS plus file system. Drive partitions of up to 2 terabytes (2000 gigabytes) can be used.

Pro Tools 24 MIX and Pro Tools 24

Pro Tools 24 MIX and Pro Tools 24 systems require that you use FWB Software’s Hard Disk ToolKit™ PE for drive formatting and maintenance. This software is included with Pro Tools. See the Hard Disk ToolKit documentation for instructions.

Pro Tools III Systems

On Pro Tools III systems, hard drives cannot be initialized while they are connected to the Disk I/O Card. Drives must be connected to the Macintosh, initialized, then reconnected to the Disk I/O card.

Formatting Drives for Windows-based Systems

SCSI hard drives used for audio recording on Pro Tools for Windows systems must be formatted for the FAT16 or NTFS file system. Drive partitions of up to 4095 MB can be used.

See “Preparing SCSI Drives on Windows-based Systems” on page 20 for instructions on using Windows Disk Administrator to format and partition each drive.

The FAT32 specification is not supported by Pro Tools. If you try to record audio to FAT32 partitions, errors and data loss may occur.

Hard Drives Larger than 4 Gigabytes

The FAT16 file system only recognizes partitions up to 4 gigabytes in size (4095 megabytes) or smaller. The maximum size for a single audio file is also 4095 MB.

If you have a hard drive that is larger than 4095 MB, you must partition the drive into segments that are 4095 MB or smaller in order to make use of the entire drive.

Later in this chapter you will learn how to partition and format hard drives using the Windows NT Disk Administrator software.

Improving System Performance

The recording and playback performance of Pro Tools 24 MIX and Pro Tools 24 systems depends largely on the speed and efficiency of your SCSI devices. In particular, sessions with high track counts and high-density edits demand maximum SCSI performance. Following the guidelines below will help you get the most out of your system.

Use High-Performance SCSI Drives

The faster a hard drive’s access time, the better its performance. For 64 track, 24-bit recording and playback, your SCSI hard drives must provide a data transfer rate of at least 9 MB per second of sustained throughput.

Use a SCSI Accelerator

SCSI accelerator cards significantly improve SCSI throughput. If you use a dual-channel SCSI accelerator card, equally allocate audio files to drives connected to each of the two busses on the card for optimal performance.

Distribute Audio Across Multiple Drives

For best recording and playback performance, don’t record and playback all audio files in a session from the same drive. Instead, use Pro Tools disk allocation features to distribute audio files between multiple SCSI drives. See the Pro Tools Reference Guide for details.

Minimize SCSI Cable Length

Using short SCSI cables improves reliability. Table 1 provides guidelines for maximum cable lengths according to SCSI type.

Separate Video and Audio Files

If you are working with imported movies, movie files must reside on a different SCSI bus than audio files. If audio files reside on disks connected to a SCSI accelerator card, video data should reside on drives connected to a different SCSI bus.
Connecting SCSI Drives to Pro Tools MIX and Pro Tools 24 Systems

To connect an external SCSI drive:

1. Turn off power to both the computer and the hard drive.
2. Attach a SCSI cable from the SCSI port of the hard drive to the SCSI port of the computer or SCSI accelerator card depending on your system’s SCSI requirements.
3. Secure the cable’s connectors to the hard drive and computer. Loose cables can cause data loss.
4. Connect additional drives by daisy-chaining from one drive to another. Keep cable lengths to a minimum (see Table 1).
5. Verify that the last SCSI device connected is properly terminated. (See “Proper SCSI Chain Termination” on page 19.)
6. Attach power cables to the hard drives.

Table 1: Maximum cable length and number of drives supported according to SCSI type

<table>
<thead>
<tr>
<th>SCSI type and transfer rate</th>
<th>maximum cable length</th>
<th>maximum # of drives</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast SCSI 10 MB/sec</td>
<td>3 meters</td>
<td>8</td>
</tr>
<tr>
<td>Wide SCSI 20 MB/sec</td>
<td>3 meters</td>
<td>16</td>
</tr>
<tr>
<td>Ultra SCSI 20 MB/sec (8-bit narrow)</td>
<td>3 meters</td>
<td>5</td>
</tr>
<tr>
<td>Ultra SCSI 40 MB/sec (16-bit wide)</td>
<td>3 meters</td>
<td>5</td>
</tr>
<tr>
<td>Ultra SCSI 20 MB/sec (8-bit narrow)</td>
<td>1.5 meters</td>
<td>6–8</td>
</tr>
<tr>
<td>Ultra SCSI 40 MB/sec (16-bit wide)</td>
<td>1.5 meters</td>
<td>6–8</td>
</tr>
<tr>
<td>Ultra2 SCSI Low Voltage Differential (LVD) 80 MB/sec</td>
<td>12 meters</td>
<td>16</td>
</tr>
</tbody>
</table>
Proper SCSI Chain Termination

Your computer's SCSI chain must be properly terminated or your system will not function correctly. Only the last device on the chain should be terminated using the termination type recommended by the hard drive manufacturer.

The drive should use either an external terminator plug or have its internal terminators enabled. If you are using a terminator plug, Digidesign recommends that you purchase and use an active terminator.

▲ Do not enable internal termination and install an external terminator plug on the same drive! This will cause SCSI errors. See your hard drive's documentation for information regarding which type of termination it uses.

Connecting SCSI Drives To Pro Tools III Systems

(Macintosh Only)

On Pro Tools III systems, audio drives must be connected to the Disk I/O card. When properly connected, they will appear on the desktop like any other external SCSI device. A maximum of 5 hard drives can be connected (by daisy-chaining) to a single Pro Tools III Disk I/O card.

To connect an external SCSI drive:
1. Turn off power to both the computer and the hard drive.
2. Connect the included SCSI cable to your Pro Tools Disk I/O card as shown in the illustration. Push the connector into the

SCSI port on the Pro Tools card and secure it in place with its connectors.

3. Attach the other end of the SCSI cable to one of the SCSI connectors on the back of the external SCSI drive. Secure it in place with its connectors.
4 Connect any other drives by daisy-chaining from one drive to another. Keep SCSI cable lengths to a minimum. The overall SCSI chain length should not exceed 3 meters, including the Pro Tools SCSI cable.

5 Verify that the last SCSI drive connected to the Disk I/O card is properly terminated. (See “Proper SCSI Chain Termination” on page 19.)

6 Attach power cables to the hard drives.

Preparing SCSI Drives on Windows-based Systems

The Windows NT Disk Administrator allows you to partition and format SCSI hard drives for use with Pro Tools. Disk Administrator also creates a disk signature on new drives attached to your system. This signature allows Windows NT to recognize the drives and assign them a drive letter. You must run Disk Administrator whenever you connect new drives to your system.

▲ You must run Disk Administrator before you can use hard drives with Pro Tools.

To create a disk signature on a SCSI drive:
1 From the Start menu, choose Programs > Administrative Tools > Disk Administrator
2 If there is no Windows NT disk signature on the new drive(s), Disk Administrator will post a dialog asking if you want to create one. Click OK to create the signature.

Formatting and Partitioning Drives

Hard drives used as Pro Tools audio drives must be formatted with the FAT16 file system. This file system only recognizes partitions up to 4 gigabytes (4095 megabytes) in size.

If you have a hard drive that is larger than 4 gigabytes, you must partition it into segments that are 4095 MB or smaller in order to make use of the entire drive. Windows NT permits a maximum of 4 partitions per drive.

To partition and format a SCSI drive:
1 From the Start menu, choose Programs > Administrative Tools > Disk Administrator.
2 When Disk Administrator opens, select Disk Configuration from the View menu.
3 Disk Administrator lists all SCSI drives attached to your system. Your system boot drive will be identified as Disk 0, and any audio drives will be listed as Disk 1, Disk 2, and so on. Unformatted volumes are indicated by diagonal lines. The amount of Free Space available on each volume is also indicated.
4 Right-click on the rectangle representing the hard drive that you wish to partition/format.

5 In the menu that appears, choose Create.

6 Enter the desired size of the selected drive's primary partition. Maximum partition size for the FAT16 file system is 4095 MB. If you wish to create the largest possible partition, enter 4095. Click OK.

7 A dialog box appears asking you to confirm this operation. Click Yes. You will now see a 4095 MB unformatted volume.

8 Right-click on the unformatted volume, and in the menu that appears, choose Commit Changes Now.

9 Click Yes to save changes, then click OK.

10 Right-click mouse on the unformatted volume. In the menu that appears, choose Format.

11 In the Format dialog, choose FAT from the File System pull-down menu.

12 In the Volume Label field, enter a name for the volume. Names must adhere to DOS/Windows NT naming conventions.

13 Check (enable) the Quick Format box, then click Start.

14 Click OK in the dialog. Disk Administrator formats the disk.

15 When the format operation is complete, click OK.

16 Click Close to close the Format window.

17 The partitioned, formatted volume now appears in the Disk Administrator window, with a drive letter and labels indicating its name, file system, and size.

18 If you wish to create additional partitions on the drive (space permitting), or if you wish to partition and format other SCSI drives connected to your computer, repeat the above process as necessary. Otherwise, exit Disk Administrator.

* After formatting the largest blocks of a drive, a block of free space will often remain which may only be a few hundred megabytes in size. You can choose to format this space or leave it unformatted. One advantage to leaving small blocks unformatted is that it will prevent inadvertent Disk Allocation to a partition that is too small to be practical for audio recording.

## Optimizing Windows SCSI Drives

To obtain optimum audio recording performance, Digidesign recommends that you enable the Read Cache and Write Cache settings on all SCSI hard drives used for audio recording.

To do this you must use a utility such as Adaptec's EZ SCSI application (version 4.0 or later), which is included with most Adaptec SCSI accelerators and computers equipped with on-board SCSI ports utilizing the Adaptec SCSI chip set.

### To use EZ SCSI to enable Read/Write Caches:

1 Install EZ SCSI on your computer.

2 Launch SCSI Explorer.

3 Click the Disk Cache tab.

4 From the SCSI Device List, select the audio drive whose read/write caches you want to enable.

5 In the Write Cache tab, click the Enable Write Cache button. (This may already be enabled.)
6 In the Read Cache tab, click the Enable Read Cache button. (This may already be enabled.)

7 Repeat the above steps as necessary for other audio drives in your system.

8 When you have finished, exit SCSI Explorer and restart your computer.

---

**Using Macintosh Drives on Windows Systems**

For compatibility with Macintosh-based systems, Pro Tools for Windows NT lets you record and play back sessions directly from a Macintosh-formatted (HFS) drive connected to a Windows NT system. This functionality requires that all Macintosh session and audio files be stored on Macintosh-formatted drives.

To mount HFS drives on a Windows NT system, you must use the MacOpener™ software utility. A demo version of MacOpener is installed with Pro Tools.

**Installing the MacOpener Utility**

To use Macintosh-formatted HFS drives, you will need to install the MacOpener software utility. The MacOpener installer was placed on your hard drive when you installed Pro Tools, in the following location:

`Program Files\Digidesign\Pro Tools Utilities\MacOpener Demo`

**To Install MacOpener:**

1. Locate the Setup.exe file in the above location and double-click it to launch the installer.

2. Follow the on-screen instructions to install MacOpener.

3. After installation is complete, restart your computer.

**Enabling the MacOpener Driver**

By default, MacOpener is enabled and its default settings allow you to mount HFS drives. You do not need to change these settings. If you later need to enable the MacOpener Driver, do the following:

**To enable the MacOpener Driver:**

1. From the Start menu, choose Programs > MacOpener > MacOpener Driver Preferences.

2. Under Driver Settings, select Enable MacOpener Driver.

3. Under Compatibility Mode, select MacPC Compatibility Mode, and click OK.

**Mounting HFS Drives**

The first time you attach an HFS-formatted drive to a Windows NT system, you must use Disk Administrator to put a disk signature on the drive. This signature allows a Windows NT system to recognize the HFS drive and assign a drive letter. It will not interfere with normal operation when you reconnect the drive to a Macintosh computer.

**To create a disk signature:**

1. From the Start Menu, choose Programs > Administrative Tools > Disk Administrator.

22 Pro Tools TDM Hardware Installation Guide
If there is no NT signature on the new disk, the Disk Administrator will ask if you want to create one for the new drive. Click OK to create the signature.

To mount an HFS drive:
If the MacOpener utility is installed and enabled, no additional steps are required to mount HFS drives. They will appear as normal system drives after you connect them and restart your computer.

Formatting and Maintaining HFS Drives
While it is possible to use MacOpener to format HFS drives from a Windows NT machine, this can yield unpredictable results. If you need to format an HFS drive, connect it to a Macintosh computer and use a Macintosh formatting utility.

Don't Use Windows NT Disk Utility Software on HFS Drives
Disk utility software for the Windows NT platform (such as Norton Utilities for Windows) should not be used on HFS drives. These utilities do not recognize HFS-formatted drives and may try to reformat them. This could cause format errors on the HFS drive and result in data loss.

If you need to perform disk maintenance on an HFS-formatted drive, connect the drive to a Macintosh computer and use a Macintosh utility.

Using The Mt. Digi Utility
(Pro Tools III/Macintosh Systems Only)
Pro Tools III systems includes a utility called Mt. Digi™. This Control Panel device is useful for enabling fast SCSI transfer mode and adjusting the time that your system takes to scan and locate hard drives connected to the Disk I/O SCSI bus.

After you have installed Pro Tools software, refer to the information given here to learn how to use Mt. Digi to improve hard drive-related system performance.

Enabling Fast SCSI Transfers
Mt. Digi allows you to enable what is called fast SCSI mode. This mode, also known as synchronous transfer mode, is supported by SCSI 2 or newer hard drives. It allows faster transfer of data to and from your hard drive via the SCSI bus on Pro Tools III Disk I/O cards.

Since this can help improve system performance, Digidesign recommends that you enable this option. If, however, you have an older SCSI I-type drive, or are having disk reliability problems, you may wish to leave this option off.

* Use an active terminator if you plan to use Fast SCSI mode.

To activate Fast SCSI transfers:
1. From the Apple menu, choose the Mt. Digi Control Panel. (You must have first run the Pro Tools Software Installer.)
2. Select Enable Fast SCSI.
3 Restart your computer for the change to take effect.

4 If a drive does not function properly when fast SCSI transfers are enabled, deselect the Enable Fast SCSI option and restart your computer.

Adjusting Scan Times
(Pro Tools III Systems Only)

The Mt. Digi Control Panel also allows you to provide additional time for your system to recognize drives that may be slow to mount, or alternatively, increase the load speed of the DigiSystem INIT by decreasing drive scan time. You can do this by adjusting the Scan Time setting, which controls the time your system spends scanning for hard drives. The default scan time is 1000 ms.

To adjust drive mount scan time with Mt. Digi:
1 From the Apple menu, choose the Mt. Digi Control Panel.
2 Using the up/down arrows, adjust the optimum scan time for your drive.
3 Each time you change the values, click the Mount button. Mt. Digi will scan the Disk I/O SCSI bus and attempt to mount your drive. If you have set a time that is too short, the drive may not respond quickly enough and fail to appear on the Desktop.
4 If a drive fails to mount, increase the scan time until it does.

Mounting Drives with Mt. Digi

A third use for the Mt. Digi Control Panel is to mount hard drives turned on after starting your computer without having to restart your system.

To mount hard drives with Mt. Digi:
1 From the Apple menu, choose the Mt. Digi Control Panel.
2 Click the re-scan button to scan the SCSI devices currently connected to your system. You can toggle between multiple Pro Tools Disk I/O cards by clicking Card Slot =.
3 Click Mount to mount the drives that appear on the chosen SCSI bus.

† Though the Mount button allows you to mount drives without restarting your system, they will not be in Fast SCSI mode even if the Enable Fast SCSI option has been enabled. You must restart your computer to enable Fast SCSI mode.
This chapter explains how to connect Pro Tools to a mixer, amplification system, digital recorders, and SMPTE synchronization devices.

The information is organized according to the type of interface or Pro Tools configuration you have. Instructions are provided for:

- 888/24 I/O
- 882/20 I/O
- 1622 I/O

If you have an ADAT Bridge I/O Interface, refer to the ADAT Bridge I/O User’s Guide for details on connecting it to your studio.

Choosing an Output Mode

Before you make any connections, you should determine how you want to use Pro Tools with the other elements in your studio, such as your mixing console and outboard effects devices.

Pro Tools software provides you with two different output modes, direct outputs and stereo mix outputs. In direct outputs mode, each track/channel is routed to a discrete output on the Audio Interface. In this mode, no panning controls are available.

Stereo Mix Outputs Mode

Stereo mix outputs mode is useful for stereo final mixes of all the elements of your Pro Tools Sessions. Using stereo mix outputs mode with more than one pair of stereo outputs can be very useful in post production for creating stem and M&E (music and effects) mixes, where it’s convenient to have audio elements in stereo pairs.

Direct Outputs Mode

Direct outputs mode is useful for laying back elements to multitrack tape or feeding audio to individual channels of a mixing console.

To select an output mode in Pro Tools, see “Choosing an Output Mode” on page 54.
The 888/24 I/O Interface

This section explains each of the connectors and indicators on the front and back panels of the 888/24 I/O Interface, how they are used, and offers suggestions for connecting the 888/24 I/O to your studio.

888/24 I/O Front Panel

The 888/24 I/O has the following front panel indicators, moving from left to right:

1. Power
   This switch applies power to the 888/24. The “I” position is on. The “O” position is off.

2. Sync Mode
   The Sync Mode LEDs indicate which sample rate clock reference is currently used by the analog-to-digital converters (ADCs) and the digital-to-analog converters (DACs).
   - **Internal** This is the 888/24 I/O standard setting. In this mode, the 888/24 I/O sample rate is generated by its internal crystal oscillator (whose frequency is determined by the Sample Rate setting in the Session Setup window). Internal mode should be active whenever the 888/24 I/O is not synchronized to an external clock source.
   - **Digital** This setting indicates that an AES/EBU or S/PDIF word clock signal is currently the source for the 888/24 I/O sample rate. This is the setting to use for inputting material from DAT recorders or other digital devices.
   - **Slave** This LED is lit when the 888/24 I/O sample rate is synchronized to another Digidesign Audio Interface or synchronization peripheral. In this mode, the sample rate of the slave interface is derived from
   - Because some digital audio devices do not output proper clock when they are not playing back, leaving the 888/24 I/O in Digital Sync Mode may cause Pro Tools audio playback quality to suffer, or play back at the wrong pitch. If you are using digital I/O, reset the Sync Mode from Digital to Internal after inputting material.

The 888/24 I/O can only synchronize to and receive word clock lock on channels 1–2 of its digital inputs. To synchronize your system to an external digital clock source, it must be connected to digital inputs 1–2 of the 888/24 I/O. In an expanded Pro Tools system, the system clock is carried by the Audio Interface connected to the first Pro Tools card in your system. This Audio Interface will act as the master interface in your system. All other Audio Interfaces will be slaved to it.
the frequency of the incoming master clock signal present at the Slave Clock (256x) port.

The 888/24 I/O automatically switches to this mode when a Slave Clock Out signal from another Digidesign Interface, Universal Slave Driver, Video Slave Driver, or SMPTE Slave Driver is connected to the 888/24 I/O Slave Clock In port.

In expanded Pro Tools systems, the Super Clock output of the master Audio Interface locks all other interfaces together with sample accuracy, keeping all signals phasesynchronous.

* When slaving to a Digidesign Universal Slave Driver, Video Slave Driver, or SMPTE Slave Driver, set the clock source to Internal. The Audio Interface will automatically switch to Slave mode when it detects the 256x input clock.

### 3. Sample Rate and 1–2 Format Indicators

These LEDs indicate the sample rate of the 888/24 I/O internal crystal oscillator and the digital format (AES/EBU or S/PDIF) of the audio input signal to channels 1 and 2.

The choice of digital format for these two channels is made in the Session Setup window or Hardware Setup dialog. Digital input pairs 3–4, 5–6, and 7–8 of the 888/24 I/O are always AES/EBU. Sample Rate is set in the Session Setup window or Hardware dialog in Pro Tools.

The 888/24 I/O provides the following sample rates:

**48 kHz** This is a standard sampling rate of many professional audio devices. It is recommended for use with devices that cannot receive digital transfers at 44.1 kHz.

**44.1 kHz** This is the compact disc standard sampling rate and the Pro Tools default sample rate. To avoid the need for sample rate conversion, you should use this rate when you are recording material that will ultimately be published on a compact disc.

> When you are using an external digital source such as a DAT recorder, the front panel of the 888/24 I/O indicates only the internal oscillator sample rate, not that of the external digital source.

### 4. Level Meters

The 888/24 I/O level meters monitor the channel outputs of Pro Tools. Input levels are monitored on-screen in the Pro Tools software.

The 888/24 I/O is factory calibrated so that a meter reading of −18 dB corresponds to the 888/24 I/O nominal operating level (which can be set to either +4 dBu or −10 dBV). If you sent the output to an analog device with a VU meter, this would correspond to “0 VU” on the VU meter.

The red LED indicators on the Audio Interface indicate both full-code (highest level before clipping) and clipping of Pro Tools output signals. The on-screen meters in Pro Tools software indicate clipping when at least three consecutive full-code samples follow each other.
5. Input Level Trims

The 888/24 I/O analog inputs are factory calibrated at a –18 dB nominal level, referenced to a full code signal. This means that at the nominal reference input level (either +4 dBu or –10 dBV), you have 18 dB of headroom before clipping. The input level trim pots allow adjustment of the 888/24 I/O input levels to match the operating level of your external equipment. Adjustments can be made with a Phillips screwdriver.

6. Output Level Trims

The 888/24 I/O analog outputs are factory calibrated at a –18 dB nominal level, referenced to a full code signal. This means that at the nominal reference output level (either +4 dBu or –10 dBV), you have 18 dB of headroom before clipping. The output level trim pots allow adjustment of the 888/24 I/O output levels to match the operating level of your external equipment. Adjustments can be made with a Phillips screwdriver.

To calibrate the input and output levels of the 888/24 I/O to match your mixing console or other devices in your studio, use Calibration Mode and the Signal Generator Plug-In in Pro Tools.

Instructions for calibrating the 888/24 I/O appear in Appendix B of this Guide.

888/24 I/O Back Panel

The 888/24 I/O has the following back panel connectors, moving from left to right:

Back panel of the 888/24 I/O

1. Analog Audio Outputs

These are balanced male XLR connectors for analog audio output connections. All eight output channels are continuously active. The 888/24 I/O analog outputs feature 24-bit digital-to-analog converters.

2. Analog Audio Inputs

These are balanced female XLR connectors for analog audio input connections. The 888/24 I/O analog inputs feature 24-bit analog-to-digital converters. Because input channels 1–8 of the 888/24 I/O are software selectable in pairs between analog or digital format, analog input to a channel pair is disabled when digital input format is chosen for that channel.

The 888/24 I/O analog audio connectors are balanced XLRs with pin 2 wired hot, (or “+”); pin 3 cold, (or “–”); and pin 1 ground.
3. AES/EBU Digital Outputs 1–8

The 888/24 I/O AES/EBU output jacks are balanced, three conductor, XLR connectors which output a 24-bit digital data stream. Output is continuously active on both the AES/EBU and S/PDIF jacks even when the 888/24 I/O input selector is set to analog.

4. AES/EBU Digital Inputs 1–8

The AES/EBU digital format is used in many professional digital audio devices, including some DAT recorders. The Interface’s AES/EBU input jacks are balanced, three conductor, XLR connectors which accept a full 24-bit digital data stream.

For AES/EBU connections, 110-ohm cables are highly recommended for use in professional installations. For best results, cable lengths should not exceed 30 meters.

Input channels 1–8 of the 888/24 I/O are software-selectable in pairs between analog or digital format. Digital input to a channel pair is disabled when analog input format is chosen for that channel in the Hardware Setup dialog. Input to AES/EBU input channels 1–2 is disabled when S/PDIF digital format is chosen for these inputs in the Pro Tools Session Setup window.

5. 50-pin Interface Connector

This 50-pin Computer connector is used to connect the 888/24 I/O to a MIX card, d24 audio card, Disk I/O card, or a DSP Farm card. The necessary cable is supplied with your Audio Interface. If you plan to connect two 888/24 I/O Interfaces to a MIX card or d24 card, a 16-channel peripheral cable adapter is necessary. (This cable is available from your Digidesign dealer.)


The Sony Phillips Digital Interface Format (S/PDIF) is used in many professional and consumer CD players and DAT recorders. The 888/24 I/O S/PDIF in/out jacks are unbalanced 2-conductor phono (RCA) jacks which utilize a full 24-bit digital data stream. To avoid RF interference, use 75-ohm coaxial cable for S/PDIF transfers and keep the cable length to a maximum of 10 meters.

Because input channels 1–2 are software selectable between analog or digital format, input to these two digital channels is disabled when analog input is chosen or when AES/EBU digital format is chosen in the Pro Tools Session Setup window. Output is continuously active on both the AES/EBU and S/PDIF output jacks, regardless of which digital input format is selected for channels 1–2. To avoid RF interference, use 75-ohm coaxial cable for S/PDIF transfers and do not exceed a cable length of 10 meters.

7/9. Slave Clock In/Out

The Slave Clock Out jack is a standard BNC type connector that outputs a 256 times sample rate Super Clock signal for slaving and synchronizing multiple Digidesign Interfaces and synchronization peripherals together.

When the 888/24 I/O Sync Mode is set to Internal, connecting a valid Slave Clock Out signal to this port will cause the 888/24 I/O to automatically switch to Slave mode. When the 888/24 I/O is the master interface or the first interface in a chain, Digital sync mode overrides the Slave mode.
Clock input, and an incoming Slave Clock Out signal will not switch the 888/24 I/O to Slave mode.

Because crucial timing data is passed over these ports, you should use high-quality, 75-ohm RG-59 cables for making connections, and keep total cable length to less than 3 meters between interfaces.

8. Power Input

This connector accepts a standard AC power cable. The Interface is auto power-selecting (100V to 240V) and will automatically work with a standard modular cable to connect to AC power receptacles in any country.

---

**Changing Operating Levels of Individual 888/24 I/O Channels**

The 888/24 I/O is factory set to +4 dBu operating levels for input and output. However, the 888/24 I/O allows you to individually switch any of its analog inputs or outputs to either a +4 dBu or –10 dBV operating level by moving internal jumpers on its circuit board.

![Diagram showing input and output level switches inside the 888/24 I/O](image)

*The location of input and output level switches inside the 888/24 I/O*

**To change the operating level of an input channel:**

1. Turn off your computer and the 888/24 I/O.
2. With a Phillips screwdriver, remove the screws from the top of the 888/24 I/O.
3. Using the 1/16-inch hex wrench included with the 888/24 I/O, carefully remove the front four panel screws as noted on the bag containing the hex wrench.
4. Lift the top off of the 888/24 I/O.
Chapter 4: Connecting Your Studio

31

5 Inside the 888/24 I/O chassis, next to each of the channel input trims, there is a jumper switch with a removable cap. Locate the jumper switch for the channel you wish to modify. Gently lift the cap off the 3-pronged connector. Place it in the position corresponding to the operating level that you desire. For +4 dBu levels, it should be placed over the rear two prongs. For –10 dBV levels, it should be placed over the front two prongs.

6 After you have made the desired changes, replace the top of the 888/24 I/O.

7 Replace the four front panel screws using the hex wrench.

8 Replace the top screws with a Phillips screwdriver.

4 To find the channel output switches, detach the front part of the ribbon cable at the right side of the chassis. To do this, grip both sides of the black connector and gently pull up.

5 With the ribbon cable out of the way you’ll see eight 3-pronged jumper switches, each with a removable cap. Locate the switch for the channel you wish to modify.

Setting the input level jumper switches

**Setting the output level jumper switches**

6 Gently lift the cap off of the jumper switch. Place it in the position corresponding to the operating level that you desire. For +4 dBu levels, it should be placed over the left two prongs. For –10 dBV levels, it should be placed over the right two prongs.

7 After you have made the desired changes, reconnect the ribbon cable and put the top back on the 888/24 I/O.

8 Replace the four front panel screws using the hex wrench.

9 Replace the top screws with a Phillips screwdriver.

---

**Setting the input level jumper switches**

To change the operating level of an output channel:

1 Turn off your computer and the 888/24 I/O.

2 Using the 1/16-inch hex wrench included with the 888/24 I/O, carefully remove the front four panel screws as noted on the bag containing the hex wrench.

3 With a Phillips screwdriver, remove the screws from the top of the 888/24 I/O and lift the top off of the 888/24 I/O.
Making Signal Connections to the 888/24 I/O

Depending on how you plan to use the 888/24 I/O, the way you connect it to your studio will vary.

Choosing between +4 dBu and –10 dBV operation modes

The 888/24 I/O can be set to operate at +4 dBu or –10 dBV input and output levels. It is important that you determine which line level mode is appropriate for your studio. In +4 dBu operating mode, the 888/24 I/O is a 24-bit digital audio device capable of producing audio signals at or near +26 dBu.

Check the owner's manual for your mixer, power amplifier or effects processor to see if it can handle this load. If it cannot, consider setting the 888/24 I/O to operate at –10 dBV line levels.

Consider the following when connecting a mixer:
- If your mixer cannot handle more than 1.5V (RMS) inputs at +4 dBu, then you should set the 888/24 I/O to run at –10 dBV line level.
- If your mixer can handle up to 8.5V (RMS) inputs, or has pads or attenuators on its inputs, then you can use the +4 dBu setting on the 888/24 I/O.

Most manuals contain device input specifications, including whether or not there are pads or attenuators. Consult the manufacturer of your mixer or power amplifier for further information.

Setting Up Your Studio

The following diagram illustrates a typical studio setup, with the 888/24 I/O connected to a mixing console, effects and other equipment.

A typical studio configuration

The 888/24 I/O analog audio connectors are balanced XLRs with pin 2 wired hot (or “+”), pin 3 cold (or “–”), and pin 1 ground.

If you are connecting a balanced system, pin 1 and shield should be connected at the input only (not at the output). This will prevent ground loops between the shield and pin 1 conductor.

If you are connecting an unbalanced signal to the 888/24 I/O inputs or outputs, connect only pin 2 to the “+” signal, and pins 1 and 3 to ground at all inputs only.
Using the 888/24 I/O Interface as Stand-Alone Audio Converter

The 888/24 I/O can be used apart from Pro Tools as a stand-alone 8-channel, 24-bit, analog-to-digital or digital-to-analog converter.

Before you use the 888/24 I/O in stand-alone mode:

1. Turn off the 888/24 I/O.
2. Do not turn on your computer while the 888/24 I/O is in stand-alone mode. If you do, the 888/24 I/O will stop functioning in stand-alone mode.

To use the 888/24 I/O as a stand-alone A/D converter:

1. Turn off any digital devices that may send a word clock signal to the 888/24 I/O channel 1–2 digital input ports.
2. Turn on the 888/24 I/O. The 888/24 I/O searches briefly for a word clock signal on channels 1–2 of its digital input ports.
3. If the 888/24 I/O does not detect word clock, it functions as a stand-alone A/D converter using its internal clock. In this mode you will use analog inputs 1–8 and AES/EBU outputs 1–8.

The default sample rate of the 888/24 I/O in stand-alone A/D mode is 44.1 kHz. To change this default setting to 48 kHz, you must open the 888/24 I/O and manually reset it by moving an internal jumper switch. Instructions for doing this are provided in the 888/24 I/O Installation Guide.

To use the 888/24 I/O as a stand-alone D/A converter:

1. Make sure that a digital device providing a word clock signal is connected to AES/EBU inputs 1–2 of the 888/24 I/O and turned on.
2. Turn on the 888/24 I/O. The 888/24 I/O will search for a valid word clock or a word clock signal on channels 1–2 of its digital input ports.
3. When a valid word clock lock is recognized, the 888/24 I/O will enter digital sync mode and function as a stand-alone D/A converter using AES/EBU inputs 1–8 and analog outputs 1–8.

The 888/24 I/O D/A sample rate is determined by the sample rate it detects on channels 1–2 of its AES/EBU inputs.

The 888/24 I/O defaults to listening to a digital word clock signal on channels 1–2 of its AES/EBU digital input ports. To use a S/PDIF device as your source of word clock, you must reset this default by opening the 888/24 I/O and moving an internal jumper switch. Instructions for doing this are provided in the 888/24 I/O Installation Guide. That Guide also provides instructions for changing other stand-alone mode default parameters such as sample rate and DAC muting.

To return the 888/24 I/O to Pro Tools-based operation:

- Turn on your computer.
- or –
- If your computer is on, launch Pro Tools.
The 882/20 I/O Interface

This section explains all of the connectors and indicators on the front and back panels of the 882/20 I/O Interface, how they are used, and offers suggestions for connecting the 882/20 I/O to your studio.

882/20 I/O Interface Front Panel

The 882/20 I/O has the following front panel indicators, moving from left to right:

1. **Power**
   This switch applies power to the 882/20. The “I” position is on. The “O” position is off.

2. **Sync Mode**
   The Sync Mode LEDs indicate which sample rate clock reference is currently used by the analog-to-digital converters (ADCs) and the digital-to-analog converters (DACs).

   **Internal** This is the 882/20 I/O standard setting. In this mode, the 882/20 I/O sample rate is generated by its internal crystal oscillator (whose frequency is determined by the Sample Rate setting in the Session Setup window). Internal mode should be active whenever the 882/20 I/O is not synchronized to an external clock source.

   **Digital** This setting indicates that a S/PDIF word clock signal is the source for the 882/20 I/O sample rate. This is the setting you would use for inputting material from DAT machines or other S/PDIF digital devices.

   To use the 882/20 I/O digital input and output as an effects send and return to a digital effects device, you should set the 882/20 I/O to Internal Sync Mode. You should then set the digital effects device to accept an external digital clock (from the 882/20 I/O) so it synchronizes with Pro Tools.

   In an expanded system, the system clock is carried by the Audio Interface connected to the first Pro Tools card in your system. This Audio Interface will act as the master interface in your system, and all other Audio Interfaces will be slaved to it. Only the master interface allows you to set the Sync Mode. Slaved interfaces do not allow this parameter selection.

   ▲ Because some digital audio devices do not output proper clock when they are not playing back, leaving the 882/20 I/O in Digital Sync Mode may cause Pro Tools audio playback quality to suffer, or to play back at the wrong pitch. If you are using digital I/O, reset the Sync Mode from Digital to Internal after inputting material.

   **Slave** This LED is lit when the 882/20 I/O sample rate is synchronized to another Digidesign Audio Interface or synchronization peripheral. In this mode, the sample rate of the slave interface is derived from the frequency of the incoming master clock signal present at the Slave Clock (256x) port. The 882/20 I/O automatically
switches to this mode when a Slave Clock Out signal from another Digidesign Interface, Universal Slave Driver, Video Slave Driver, or SMPTE Slave Driver is connected to its Slave Clock In port.

In expanded Pro Tools systems, the Super Clock output of the master Audio Interface locks all other interfaces together with sample accuracy, keeping all signals phase-synchronous.

* When slaving to a Digidesign Universal Slave Driver, Video Slave Driver, or SMPTE Slave Driver, set the clock source to Internal. The Audio Interface will automatically switch to Slave mode when it detects the 256x input clock.

3. **Ch 1–2 Input**

This LED indicates the format (analog or digital) of the audio input signal to channels 1 and 2. In Pro Tools, you choose analog or digital input for these two channels in the Session Setup window. Input channels 3 through 8 of the 882/20 I/O are always analog.

4. **Sample Rate**

These LEDs display the current sample rate of the 882/20 I/O internal crystal oscillator, which can be either 44.1 kHz or 48 kHz. In Pro Tools, this is set in the Session Setup window.

The 882/20 I/O provides the following sample rates:

**48 kHz** This is a standard sampling rate of many professional audio devices. It is recommended for use with devices that cannot receive digital transfers at 44.1 kHz.

**44.1 kHz** This is the compact disc standard sampling rate and the Pro Tools default sample rate. To avoid the need for sample rate conversion, you should use this rate when you are recording material that will ultimately be published on a compact disc.

* When you are using an external digital source such as a DAT recorder, the front panel of the 882/20 I/O indicates only the internal oscillator sample rate, not that of the external digital source.

5. **Signal Present LEDs**

These LEDs indicate whether signal is present (above the level of –30 dB) at a given channel’s output. These LEDs indicate the presence of channel output signals, not input signals. Input signals are monitored on-screen in the Pro Tools software. The LEDs do not indicate clipping. Clipping is indicated by the on-screen meters in Pro Tools software.
882/20 I/O Back Panel

The 882/20 I/O has the following back panel connectors, moving from left to right:

1. Analog Audio Inputs
These are balanced, 1/4-inch TRS jacks for analog audio input connections. The 882/20 I/O analog inputs feature 20-bit analog-to-digital converters.

Input operating levels are switchable between +4 dBu and –10 dBV operation. Unbalanced connections are supported through the use of standard 1/4-inch TRS mono phone plugs.

Because input channels 1–2 of the 882/20 I/O are software selectable between analog or S/PDIF digital format, input to these two analog channels is disabled when S/PDIF digital input format is chosen in the Pro Tools Hardware Setup dialog.

The 882/20 I/O analog inputs are factory calibrated at a –14 dB nominal level, referenced to a full code signal. This means that at the nominal reference input level (either +4 dBu or –10 dBV), you have 14 dB of headroom before clipping.

2. Analog Audio Outputs
These are balanced, 1/4-inch TRS jacks for analog audio output connections. The 882/20 I/O analog outputs feature 20-bit digital-to-analog converters.

All eight output channels are continuously active. Output operating levels are switchable between +4 dBu and –10 dBV operation. Unbalanced connections are supported through the use of standard 1/4-inch TRS mono phone plugs.

The 882/20 I/O analog outputs are factory calibrated at a –14 dB nominal level, referenced to a full code signal. This means that at the nominal reference output level (either +4 dBu or –10 dBV), you have 14 dB of headroom before clipping.

3. Slave Clock In/Out
The Slave Clock Out jack is a standard BNC type connector that outputs a 256x audio sample rate master Super Clock signal for slaving and synchronizing multiple Digidesign Interfaces and synchronization peripherals together.

The Slave Clock In jack is a standard BNC type connector designed to receive a Slave Clock Out signal from another Digidesign Interface, a Universal Slave Driver™, Video Slave Driver™, or SMPTE Slave Driver™ for synchronizing multiple Digidesign Interfaces and synchronization peripherals together.
When the 882/20 I/O Sync Mode is set to Internal, connecting a valid Slave Clock Out signal to this port will cause the 882/20 I/O to automatically switch to Slave mode. When the 882/20 I/O is the master interface or the first interface in a chain, Digital sync mode overrides the Slave Clock input, and an incoming Slave Clock Out signal will not switch the 882/20 to Slave mode.

Because crucial timing data is passed over these ports, you should use high-quality, 75-ohm RG-59 cables for making connections, and keep total cable length to less than 3 meters between interfaces.

4. S/PDIF Digital Input/Output
The Sony Phillips Digital Interface Format (S/PDIF) is used in many professional and consumer CD players and DAT recorders. The 882/20 I/O S/PDIF jacks are unbalanced, two-conductor, phono (RCA) jacks. Because input channels 1–2 of the 882/20 I/O are software selectable between analog or digital format, input to these two digital channels is disabled when analog input is chosen in the Hardware Setup dialog in Pro Tools. Output is continuously active on the S/PDIF output jack, even if the 882/20 I/O input selector is set to Analog in the Hardware Setup dialog. To avoid RF interference, use 75-ohm coaxial cable for S/PDIF transfers and do not exceed a cable length of 10 meters.

5. 50-pin Interface Connector
This 50-pin connector is used to connect the 882/20 I/O to a MIX card, d24, Disk I/O, or DSP Farm card. The necessary cable is supplied with your Audio Interface. If you plan to connect two 882/20 I/O Interfaces to a MIX card or d24 card, a 16-channel peripheral cable adapter is necessary. (This cable is available from your Digidesign dealer.)

6. Power Input
This connector accepts a standard AC power cable. The Interface is auto power selecting (100 V–240 V), and will automatically work with a standard modular cable to connect to AC power receptacles in any country.
Making Signal Connections to the 882/20 I/O

Depending on how you plan to use the 882/20 I/O, the way you connect it to your studio will vary.

Choosing between +4 dBu and –10 dBV operation modes

The 882/20 I/O can be set to operate at +4 dBu or –10 dBV input and output levels. It is important that you determine which line level mode is appropriate for your studio. In +4 dBu operating mode, the 882/20 I/O is a 20-bit digital audio device capable of producing audio signals at or near +18 dBu. Check the owner’s manual for your mixer, power amplifier or effects processor to see if it can handle this load. If it cannot, consider setting the 882/20 I/O to operate at –10 dBV line levels.

Consider the following when connecting a mixer:

- If your mixer cannot handle more than 1.5V (RMS) inputs at +4 dBu, then you should set the 882/20 I/O to operate at –10 dBV line level.
- If your mixer can handle up to 8.5V (RMS) inputs, or has pads or attenuators on its inputs, then you can use the +4 dBu setting on the 882/20 I/O.

Most manuals contain device input specifications, including whether or not there are pads or attenuators. Consult the manufacturer of your mixer or power amplifier for further information.

Setting Up Your Studio

The following diagrams provide general suggestions for connecting studio gear to your system. The first illustrates a studio setup with the 882/20 I/O connected to a mixing console, with effects and other gear routed into the console as well. The second diagram shows a setup without a mixer, where effects and monitoring gear are connected directly to the 882/20 I/O.
Using the 882/20 I/O Interface as Stand-Alone Audio Converter

The 882/20 I/O can be used apart from Pro Tools as a stand-alone 2-channel, 20-bit, analog-to-digital or digital-to-analog converter.

The 882/20 I/O always operates at –10 dBV when in stand-alone mode.

Before you use the 882/20 I/O in stand-alone mode:

1. Turn off the 882/20 I/O.
2. Do not turn on your computer while the 882/20 I/O is in stand-alone mode. If you do, the 882/20 I/O will stop functioning in stand-alone mode.

To use the 882/20 I/O as a stand alone A/D converter:

1. Turn off any digital devices that may send a word clock signal to the 882/20 I/O S/PDIF digital input.
2. Turn on the 882/20 I/O. The 882/20 I/O searches briefly for a word clock signal on channels 1–2 of its digital input ports.
3. If the 882/20 I/O does not detect word clock, it functions as a stand-alone A/D converter using its internal clock. In this mode you will use analog inputs 1–2 and the S/PDIF output.

In stand-alone mode, the 882/20 only operates at a 44.1kHz sample rate. If you wish to convert analog signals into 48kHz digital audio, you must launch Pro Tools (or any other software which supports the 882/20 I/O) to change the default sample rate.

To use the 882/20 I/O as a stand alone D/A converter:

1. Make sure that a digital device providing a word clock signal is connected to the S/PDIF input of the 882/20 I/O and that the device is powered on.
2. Turn on the 882/20 I/O. The 882/20 I/O will search for a valid word clock on its S/PDIF input.
3. When a valid word clock lock is recognized, the 882/20 I/O will enter digital sync mode and function as a stand-alone D/A converter using the S/PDIF input and analog outputs 1–2.

The 882/20 I/O sample rate is determined by the sample rate that it detects on its S/PDIF input.

To return the 882/20 I/O to Pro Tools-based operation:

- Turn on your computer.
- or -
- If your computer is on, launch Pro Tools.
The 1622 I/O Interface

This section explains the connectors and indicators on the front and back panels of the 1622 I/O Interface, how they are used, and offers suggestions for connecting the 1622 I/O to your studio.

1622 I/O Front Panel

The 1622 I/O has the following front panel indicators, moving from left to right:

1. Power
   This switch applies power to the 1622 I/O. The “I” position is on. The “O” position is off.

2. Sync Mode
   The Sync Mode LEDs indicate which sample rate clock reference is currently used by the analog-to-digital converters (ADCs) and the digital-to-analog converters (DACs).
   **Internal** This is the 1622 I/O standard setting. In this mode, the 1622 I/O sample rate is generated by its internal crystal oscillator (whose frequency is determined by the Sample Rate setting in the Session Setup window). Internal mode should be active whenever the 1622 I/O is not synchronized to an external clock source.

   **Digital** This setting indicates that a S/PDIF word clock signal is the source for the 1622 I/O sample rate. This is the setting to use for inputting material from DAT machines or other S/PDIF digital devices.

   To use the 1622 I/O digital input and output as an effects send and return to a digital effects device, set the 1622 I/O to Internal Sync Mode. Set the digital effects device to accept an external digital clock (from the 1622 I/O) so it synchronizes with Pro Tools.

   In expanded Pro Tools systems, the Super Clock output of the master Audio Interface locks all other interfaces together with sample accuracy, keeping all signals phasesynchronous.

   ▲ Because some digital audio devices do not output proper clock when they are not playing back, leaving the 1622 I/O in Digital Sync Mode may cause Pro Tools audio playback quality to suffer, or to play back at the wrong pitch. If you are using digital I/O, reset the Sync Mode from Digital to Internal after inputting material.

   **Slave** This LED is lit when the 1622 I/O is synchronized to another Digidesign Audio Interface or synchronization peripheral. In this mode, the sample rate of the slave interface is derived from the frequency of the incoming master clock signal present at the Slave Clock (256x) port. If the Sync Mode is set to Internal, connecting a Slave Clock Out signal from another Digidesign Interface or synchronization peripheral to the 1622 I/O Slave Clock In port will automatically switch it to Slave mode.
In expanded Pro Tools systems, the Super Clock output of the master Audio Interface locks all other interfaces together with sample accuracy, keeping all signals phase-synchronous.

When slaving to a Digidesign Universal Slave Driver, Video Slave Driver, or SMPTE Slave Driver, set the clock source to Internal. The Audio Interface will automatically switch to Slave mode when it detects the 256x input clock.

3. Ch 1–2 Input
This LED indicates the format (analog or digital) of the audio input signal to channels 1–2. In Pro Tools, you choose analog or digital input for these two channels in the Session Setup window or the Hardware Setup dialog. Input channels 3 through 16 of the 1622 I/O are always analog.

4. Sample Rate
These LEDs display the current sample rate of the 1622 I/O internal crystal oscillator, which can be either 44.1 kHz or 48 kHz. In Pro Tools, this is set in the Session Setup window or in the Hardware Setup dialog.

The 1622 I/O provides the following sample rates:
- 48 kHz This is a standard sampling rate of many professional audio devices. It is recommended for use with devices that cannot receive digital transfers at 44.1 kHz.
- 44.1 kHz This is the compact disc standard sampling rate and the Pro Tools default sample rate. To avoid the need for sample rate conversion, you should use this rate when you are recording material that will ultimately be published on a compact disc.

When you are using an external digital source such as a DAT recorder, the front panel of the 1622 I/O indicates only the internal oscillator sample rate, not that of the external digital source.

5. Input Meters
These LEDs indicate whether signal is present at a given channel’s input. Segment 1 (green) indicates −20.0 dB. Segment 2 (yellow) indicates −3.0 dB. Segment 3 (red) indicates −0.1 dB.

6. Output Meters
These LEDs indicate whether signal is present at one of the two outputs. Segment 1 (green) indicates −20.0 dB. Segment 2 (yellow) indicates −3.0 dB. Segment 3 (red) indicates −0.1 dB.

7. Channel 15–16 Direct Inputs
These are balanced, 1/4-inch TRS jacks for convenient front panel audio input connections.

Inputs can be individually calibrated from +4 dBu to −10 dBV line levels and higher in 2 dB gain steps, using the Other Options dialog (choose Setups > Hardware and click Other Options). This allows the 1622 I/O to accommodate any standard line-level input, including synthesizers, samplers and effects devices. Unbalanced connections are supported through the use of standard 1/4-inch TRS mono phone plugs.
1622 I/O Back Panel

The 1622 I/O has the following back panel connectors, moving from left to right:

[Diagram of back panel]

1. Analog Audio Inputs 1–14
These are balanced, 1/4-inch TRS jacks for analog audio input connections.

Inputs can be individually calibrated from +4 dBu to –10 dBV line levels and higher in 2 dB gain steps, using the Other Options dialog (choose Setups > Hardware and click Other Options). This allows the 1622 I/O to accommodate any standard, line-level input, including synthesizers, samplers and effects devices. Unbalanced connections are supported through the use of standard 1/4-inch TRS mono phone plugs.

The 1622 I/O analog inputs are factory calibrated at a –14 dB nominal level, referenced to a full code signal. This means you can have up to 14 dB of headroom before clipping, depending on the input levels you set in the Other Options dialog.

Because input channels 1–2 of the 1622 I/O are software-selectable between analog or S/PDIF digital format, input to these two analog channels is disabled when S/PDIF digital input format is chosen in the Pro Tools Hardware Setup dialog.

2. Analog Audio Outputs L-R
These are balanced, 1/4-inch TRS jacks for analog audio output connections. They carry Pro Tools main output channels 1–2.

The analog outputs feature 24-bit digital-to-analog converters. Both output channels are continuously active. Output operating levels are switchable between +4 dBu and –10 dBV operation.

Unbalanced connections are supported through the use of standard 1/4-inch TRS mono phone plugs.

The 1622 I/O analog outputs are factory calibrated at a –14 dB nominal level, referenced to a full code signal. This means that at the nominal reference output level (either +4 dBu or –10 dBV), you have 14 dB of headroom before clipping.

3. Slave Clock In/Out
The Slave Clock Out jack is a standard BNC type connector that outputs a 256x audio sample rate master Super Clock signal for slaving and synchronizing multiple Audio Interfaces and synchronization peripherals together.

When the 1622 I/O Sync Mode is set to Internal, connecting a valid Slave Clock signal to the Slave Clock In port will cause the 1622 I/O to automatically switch to Slave mode. When the 1622 I/O is the master interface or the first interface in a chain, Digital sync mode overrides the Slave Clock input, and an incoming Slave Clock Out signal will not switch the 1622 I/O to Slave mode.

Because crucial timing data is passed over these ports, you should use high-quality, 75-ohm RG-59 cables for making connec-
tions, and keep total cable length to less than 3 meters between interfaces.

**4. S/PDIF Digital Input/Output**

The Sony Phillips Digital Interface Format (S/PDIF) is used in many professional and consumer CD players and DAT recorders. The 1622 I/O S/PDIF jacks are 24-bit capable, unbalanced, two-conductor, phono (RCA) jacks.

Because input channels 1–2 of the 1622 I/O are software selectable between analog or digital format, input to these two digital channels is disabled when analog input is chosen in the Hardware Setup dialog in Pro Tools.

Output is continuously active on the S/PDIF output jack, even if the 1622 I/O input selector is set to analog in the Hardware Setup dialog. To avoid RF interference, use 75-ohm coaxial cable for S/PDIF transfers and do not exceed a cable length of 10 meters.

**5. 60-pin Interface Connector**

This 60-pin connector is used to connect the 1622 I/O to a MIX or d24 card. The appropriate interface cable is supplied with the 1622 I/O.

**6. Power Input**

This connector accepts a standard AC power cable. The 1622 I/O is auto power selecting (100 V–240 V), and will automatically work with a standard modular cable to connect to AC power receptacles in any country.

---

### Making Signal Connections to the 1622 I/O Interface

Depending on how you plan to use the 1622 I/O, the way you connect it to your studio will vary.

### Adjusting 1622 I/O Gain Levels

The 1622 I/O input levels are adjustable through the Pro Tools software to accommodate a variety of equipment output levels. For optimum fidelity and signal-to-noise performance, you should adjust these inputs according to the devices that you connect to them.

After you have set up, configured, and launched Pro Tools, refer to the instructions below for adjusting input gain levels for the 1622 I/O.

- For best signal-to-noise performance, set the 1622 I/O input gain to +4 dBu when recording devices that provide this output level.

**To adjust input level gain on the 1622 I/O:**

1. Connect the instrument or device to the 1622 I/O.
2. In Pro Tools, choose Setups > Hardware.
3. Click Other Options.
4. Set the input trim slider to match the output level of the connected instrument. (Refer to the manufacturer’s documentation for details.) If you do not know the output level of the device, use the default input trim level, then fine tune the input level gain using the procedure below.
5. Select the desired output gain level, +4 dBu or –10 dBV, and click Done.
To fine tune the input level gain:

1. Create an auxiliary input track. This can be either mono or stereo depending on the device you are monitoring.
2. Set the track input to the 1622 I/O input channel you just set in the Other Options dialog.
3. Play the instrument at maximum volume, sending a steady signal to the 1622 I/O. (You will not be able to hear the input signal while adjusting your levels in this dialog, but you can see the levels on the input meters of the 1622 I/O.)
4. Note where the instrument output signal registers on the on-screen meters in Pro Tools.
5. In the Other Options dialog, adjust the channel input trim slider to increase or decrease gain until you are able to achieve maximum signal level without clipping.
6. Repeat as necessary for other instruments/inputs.
7. Click Store, then Done.
8. Click OK when you have finished.

* Input trim level, output line level, and sample rate settings are stored in non-volatile memory so that the 1622 I/O will retain them when used in stand-alone mode.

Setting Up Your Studio

The diagrams below provide suggestions for connecting studio gear to your system. The first illustrates a studio setup with the 1622 I/O connected to a mixing console, with effects and other gear routed into the console as well. The second diagram illustrates a setup without a mixer, where effects processors and monitoring gear are connected directly to the 1622 I/O.

A typical studio configuration with a mixer

A typical studio configuration without a mixer
Using the 1622 I/O Interface as Stand-Alone Audio Converter

The 1622 I/O can be used apart from Pro Tools as a stand-alone 2-channel, 20-bit analog-to-digital, or 24-bit digital-to-analog converter.

Input and output levels are determined by the settings last saved by clicking the Store button in the Other Options dialog (choose Setups > Hardware and click Other Options).

▲ If no input level settings are stored, input levels default to +4 dBu and output levels default to –10 dBV.

There are no panning controls in stand-alone mode. Odd-numbered channels are hard-panned left and even-numbered channels hard-panned right. Mono instruments will play out of output L or R, but not both. Stereo instruments will play out of both outputs L and R. Output gain must be controlled directly from connected instruments.

Before you use the 1622 I/O in stand-alone mode:
1. Turn off the 1622 I/O.
2. Do not turn on your computer while the 1622 I/O is in stand-alone mode. If you do, the 1622 I/O will stop operating in stand-alone mode.

To use the 1622 I/O as a stand-alone A/D converter:
1. Turn off any digital devices that may send a word clock signal to the 1622 I/O S/PDIF digital input.
2. Turn on the 1622 I/O. The 1622 I/O searches briefly for a word clock signal on channels 1–2 of its digital input ports.
3. If the 1622 I/O does not detect word clock, it functions as a stand-alone A/D converter using its internal clock. In this mode you will use analog inputs 1–16 and the S/PDIF output.

To use the 1622 I/O as a stand-alone 24-bit D/A converter:
1. Make sure that a digital device providing a word clock signal is connected to the S/PDIF input of the 1622 I/O and that the device is powered on.
2. Turn on the 1622 I/O. The 1622 I/O will search for a valid word clock on its S/PDIF input port.
3. When a valid word clock lock is recognized, the 1622 I/O will enter digital sync mode and function as a stand-alone D/A converter using the S/PDIF input and analog outputs 1–2.

To return the 1622 I/O to Pro Tools-based operation:
◆ Turn on your computer.
   – or –
◆ If your computer is on, launch Pro Tools.
Connecting Equipment with Digital Audio Ins and Outs

Because the 888/24 I/O, 882/20 I/O, 1622 I/O, and ADAT Bridge I/O feature digital inputs and outputs, Pro Tools allows you to digitally record to or from a digital device such as a DAT recorder. The 888/24 I/O and ADAT Bridge I/O provide both AES/EBU and S/PDIF digital audio input and output. The 882/20 I/O and 1622 I/O provide S/PDIF digital audio input and output.

If you plan to use a DAT player, CD recorder, or other digital input and output device with your Pro Tools system, be sure the external device supports either the AES/EBU or S/PDIF format. Your interface’s AES/EBU inputs and outputs should only be connected to another AES/EBU device. Likewise, its S/PDIF inputs and outputs should only be connected to another S/PDIF device.

To connect your Pro Tools system to a DAT recorder:

1. Connect the digital output of the Audio Interface to the digital input of the DAT deck. Audio channels 1 and 2 will be sent out of these outputs.
2. Connect the digital output of the DAT to the digital input of the Audio Interface. The DAT recorder will be routed to Pro Tools inputs 1 and 2.

Connecting Effects Units

The 888/24 I/O, 882/20 I/O, 1622 I/O, and ADAT Bridge I/O Audio Interfaces allow you to connect effects units to your system by using any analog (or digital) inputs/outputs as auxiliary inputs/outputs for effects sends and returns. Once an effects unit is attached this way, you can send a variable amount of a track’s output to the effects unit using a send fader in Pro Tools.

Five separate send controls on each Pro Tools track allow you to route audio to any of the available outputs connected to your system or through any of the 32 internal busses in the Pro Tools TDM Mixer. Outputs can be returned to mono or stereo auxiliary inputs for automated mixing or processing.

When you are using an effect in this send-type of configuration, make sure the unit’s internal mix or balance between direct (unprocessed) and wet (effected) signal is set so that only the processed signal is returned to Pro Tools. On most effect units, a balance setting of 100% (completely wet) is the appropriate setting.

If you’ve been using an effects unit in an instrument setup, such as a guitar effects rack, you’ll probably find the balance to be below 50%. If the unit has separate dry and effect level knobs, turn dry level control off. If you don’t do this, the dry, unprocessed signal will be present in an effect’s output along with the desired processed sound, and you’ll have trouble accurately controlling the effect balance in your final mix.
Connecting Effects Units Digitally

To use your Audio Interface’s inputs and outputs as effects sends & returns to a digital effects device, set your interface to Internal Sync mode (unless it is already synchronized to an external clock source such as a DAT deck). You should then set your digital effects devices to accept an external digital clock so that they will synchronize themselves to Pro Tools. In the Pro Tools Hardware Setup dialog, set the input of the channel pair to which you have connected the digital effects device to Digital, and set the Sync Mode to Internal.

MIDI Connections

By adding a Macintosh or Windows-compatible MIDI Interface to your system, you can take advantage of all the MIDI features of Pro Tools, including recording and editing MIDI tracks, syncing to MIDI Time Code or MIDI beat clock (this requires an appropriate MIDI interface) and the use of MIDI Controllers.

For information on configuring a MIDI control surface for use with Pro Tools, see the Pro Tools MIDI Controllers Guide.

Macintosh

Blue & White Macintosh G3 computers require additional hardware to allow MIDI connections. Refer to Chapter 1 of this guide for more information.

To connect MIDI devices to your system:

1. Connect the MIDI interface to your computer according to the MIDI interface’s documentation.

2. Install any MIDI driver software required by the MIDI interface. (Once you have installed your MIDI Interface hardware and software, confirm that it is working properly using the procedure given in the interface’s documentation.)

3. Connect the MIDI OUT of your MIDI device or controller to the MIDI IN of your MIDI interface.

4. Connect the MIDI IN of your MIDI device or controller to the MIDI OUT of your MIDI interface.

For information on configuring OMS (Open Music System) software, which is required on Macintosh systems.
Windows

To connect a MIDI device or MIDI controller to your system:

1. If your MIDI interface has an accompanying MIDI card, install the card into your computer according to the card’s documentation.

2. Connect the MIDI interface to your computer according to the MIDI interface’s documentation.

3. Install any MIDI driver software required by the MIDI card/interface. (Once you have installed your MIDI Interface hardware and software, confirm that it is working properly using the procedure given in the interface documentation.)

4. Connect the MIDI OUT of your MIDI device or controller to the MIDI IN of your MIDI interface.

5. Connect the MIDI IN of your MIDI device or controller to the MIDI OUT of your MIDI interface.

Connecting SMPTE Synchronization Devices

If you intend to synchronize Pro Tools to external devices with SMPTE using MIDI Time Code, your system must be connected properly. This section provides setup suggestions for synchronizing Pro Tools to audio or video tape. For details on SMPTE and synchronization, see the Pro Tools Reference Guide.

Pro Tools and Synchronization

Pro Tools supports a type of SMPTE synchronization known as SMPTE Trigger through the use of SMPTE-to-MIDI Time Code converters. This type of synchronization allows Pro Tools to chase and start (or stop) playback and recording while slaved to other systems. With SMPTE Trigger alone, once playback or recording starts, there is no further synchronization, and Pro Tools will play back at a rate determined by the internal clock of the Audio Interface or selected external clock source.

For fairly short pieces of audio program material, SMPTE Trigger is acceptable, especially if the sync master has a fairly stable transport or is resolved to house sync or a black burst generator. In this case, the master transport and Pro Tools will probably not drift very far apart in such a short period of time.

On the other hand, if the audio piece is several minutes long, or if the sync master has an unstable transport (as in the case of a low quality recording deck striped with SMPTE, for example), SMPTE Trigger alone is probably not an acceptable solution,
since the two systems may drift apart noticeably over the duration of the source material.

A better alternative is to use Digidesign’s Universal Slave Driver.

The Digidesign Universal Slave Driver

The Universal Slave Driver (USD) is a multi-purpose synchronization peripheral that provides virtually all of the functions and connections needed to achieve synchronization to a variety of devices.

The USD allows synchronization of Pro Tools to Linear Time Code (LTC), external video black burst, or word clock signal. It supports all major industry-standard clocks and formats and can also act as a stand-alone MIDI Time Code (MTC) or VITC reader/generator.

In addition, the Universal Slave Driver offers extremely fast lockup, near-sample accurate synchronization, and an exceptionally low-jitter clock. These features provide professional performance and maximum audio fidelity under a wide range of synchronization conditions.
Making Sure Your System Is Working

After you have installed Pro Tools software and hardware, you should confirm that your system is working properly. To do this you'll install and play the demo session included on the Pro Tools Installer CD-ROM.

If you haven’t already installed Pro Tools software, do so now. See the Pro Tools Software Installation Guide for instructions.

Configuring Expanded Pro Tools Systems

(Windows Systems Only)

Before you can test an expanded Windows-based Pro Tools system, you must identify which Audio Interface is connected to which Pro Tools card. The DigiTest utility included with Pro Tools allows you to do this.

To use DigiTest:

1. Start your computer.
2. From the Start menu, choose Programs > Digidesign > Pro Tools > DigiTest. DigiTest opens, listing each of the Pro Tools cards in your system.
3. Next to each card designation is a small checkbox. Click the checkbox and the front panel meters of the Audio Interface connected to that card will light up.
4. Repeat the previous step for each Pro Tools card in your system. As you do, write down the name of the card and the type of interface connected to that card. This is necessary to configure each of the Audio Interfaces.

For example:

- MIX card #1 = 888/24 I/O #1
- MIX card #2 = 888/24 I/O #2
- DSP Farm #1 = 888/24 I/O #3

5. The Audio Interface connected to the card that appears as card #1 in the DigiTest window will function as the clock master for your Pro Tools system. If you have more than one Audio Interface, connect the one
you want to use as your clock master to Pro Tools card #1.

⚠️ You can switch an Audio Interface to a different Pro Tools card without shutting down your computer, but you must turn off the Audio Interface before doing so.

6 After properly identifying all cards/Audio Interfaces, click Test All Slots to run a brief test to confirm that your cards are operating properly.

7 When all cards pass, exit DigiTest and restart your computer.

* If DigiTest reports an error message when testing your cards, write it down before calling your local Digidesign Technical Support representative.

---

**Starting Up Your System**

Before you test your system, you must turn on all of your system components in a specific order.

**Start your Pro Tools System in this order:**

1. Turn on your external hard drives. Wait approximately ten seconds for them to come up to speed.
2. Turn on your Pro Tools Audio Interfaces. Wait at least ten seconds for them to initialize.
3. Turn on your computer. Or, if it is already on, restart it.

see the Release Notes & Documentation folder within the Pro Tools folder for late-breaking information.

---

### Installing the Demo Session

Next you will install the demo session included on the Pro Tools Installer CD-ROM.

#### Macintosh

**To install the demo session:**

1. Insert the Pro Tools Installer disc in your CD-ROM drive.
2. Double-click the file “Install Pro Tools Demo Session.”
3. Select “Pro Tools SoundCheck.” This is the session used for testing your system. The other demo sessions demonstrate more capabilities of Pro Tools. Since they are not used for testing purposes, installation is optional.
4. Choose a drive on which to install the demo session. If you have a Pro Tools III system, choose a drive that is connected to the Disk I/O card.
5. Click Install. When installation is complete, click OK to return to the Finder.

#### Windows

**To install the demo session:**

1. Insert the Pro Tools Installer disc in your CD-ROM drive.
2. Locate and double-click the “Pro Tools Demo Installer” folder.
3. Double-click the file “Install Pro Tools Demo Session.”
4. Select “Pro Tools SoundCheck.” This is the session used for testing your system. The other demo sessions demonstrate more
capabilities of Pro Tools. Since they are not used for testing purposes, installation is optional.

5 Select the desired items and click Next.  
6 Click the Browse button to choose a SCSI drive that is connected to your system and formatted for use as an audio drive. Install the demo session there.  
7 When installation is complete, click Finish to exit the Demo Installer.

---

**Opening the Demo Session**

Now you will open the demo session and begin playback to hear Pro Tools in action.

**To open the demo session:**

1 Locate and open the demo session folder.  
2 Double-click the file, “Pro Tools Sound-Check.”  
3 A dialog appears prompting you to use the Hardware dialog to configure your system. Click OK.

![The Hardware dialog]

---

**Configuring Pro Tools for the First Time**

The first time you open Pro Tools, you must use the Hardware dialog to configure the parameters for each Pro Tools card and Audio Interface in your system.

If you have a system with multiple cards and/or Audio Interfaces, you must configure each by selecting the appropriate items from the pop-up menus in this dialog.

You must select the card, identify the interface connected to it, then set the parameters for that interface—repeating this for each card/interface in your system.

▲ Some parameters explained below do not apply to all Pro Tools configurations.

**To configure Pro Tools:**

1 From the Card pop-up, select the Digidesign card type.  
2 From the Interface port pop-up, choose the port to which your Audio Interface is connected (port A or port B).  
3 Choose port A if only one Audio Interface is connected to the card. If two Audio Interfaces are connected to your card, follow the steps below for each port/interface.

* The Interface port pop-up does not appear for Pro Tools III systems.

4 From the Interface pop-up, choose the Audio Interface connected to the card you selected in the previous step.  
5 From the Sample Rate pop-up, select the desired sample rate for the current card and interface (the sample rate of the demo session is 44100 Hz).
5 From the Sync Mode pop-up, select the appropriate sync mode on the currently selected interface (Internal or Digital). In most cases you will use Internal. Digital is used primarily for inputting data from DAT or other digital sources.

6 From the Digital Format pop-up, select the desired digital format of Channels 1–2 of the currently selected interface (AES/EBU or S/PDIF).

7 From the Ch 1–2 Input pop-up, select the input format of Channels 1–2 of the currently selected interface (Analog or Digital).

8 Click Recalibrate Inputs to recalibrate the analog-to-digital convertors of the Audio Interface and remove any DC offset that may have built up in them. (For an explanation of DC offset, see the DigiRack Plug-Ins Guide.)

9 Click Other Options for additional configuration options specific to the Audio Interface. These include:
   - Setting the input format (analog or digital) of each pair of input channels on a 888/24 I/O
   - Configuring the level sensitivity and peak hold settings for the output level meters on the front panel of the 888/24 I/O
   - Selecting S/PDIF compatibility with Tascam DA30 DAT recorders

   To record to or from a Tascam® DA30 DAT recorder you must set S/PDIF compatibility to “Tascam.” To record to or from a non-Tascam DA30 DAT recorder, set S/PDIF compatibility to “Other.”

   - Enabling or disabling DAC Muting (mutes the 888/24 I/O digital-to-analog convertors when its output level falls below a certain threshold, to reduce noise)
   - Setting the input and output levels of a 1622 I/O

10 Configure the Other Options parameters as desired and click Done.

11 Click OK to close the Hardware Setup dialog. The demo session opens.

To play the demo session:
1. Adjust the volume control on your monitoring system so that it is set relatively low. You can adjust levels as the demo begins to play.
2. Press the Spacebar on your keyboard to begin playback. To stop playback, press the Spacebar again.

Welcome to Pro Tools!

If you weren’t able to play the demo session, see Appendix D of the Pro Tools Reference Guide for troubleshooting tips.

Choosing an Output Mode

Before you start your first session, configure your system’s output mode. Pro Tools has two different output modes, direct outputs mode and stereo mix outputs mode. These allow you to set Pro Tools channel outputs to match your studio setup.

Direct Outputs Mode

In direct outputs mode, track outputs are routed to a single Audio Interface output: 1, 2, 3, 4, 5, 6, 7, 8, and so on. Panning controls are not available in this mode.
Stereo Mix Outputs Mode

In stereo mix outputs mode, track outputs are routed to a pair of Audio Interface outputs: 1–2, 3–4, 5–6, 7–8, and so on. Each track has controls for panning between the selected output pair.

To choose an output mode:

1. From the Setups menu, choose Preferences and click the Operation button.
2. Choose the desired operating mode and click Done.

Choosing an output mode
Determining Slot Order On Macintosh Computers

To properly install Pro Tools cards in Macintosh computers you must first determine the slot numbering for your particular model. The DigiTest application, located in the Digidesign Utilities folder, allows you to do this.

* DigiTest is included on the Pro Tools Installer CD-ROM and installed with Pro Tools. If you haven’t already run the Pro Tools Installer, do so now.

To see slot numbering for your computer:
1. Open DigiTest.
2. From the SlotPictures menu, choose your Macintosh model. A drawing of the computer is shown, with its slots numerically labeled.
3. Make a note of the slot order shown in the illustration.
4. Quit DigiTest.
5. Shut down your computer.
6. Using the slot numbering indicated by DigiTest, install your Pro Tools cards in the order given in the section that follows.

Card Order Guidelines for Each Pro Tools System

The following are card installation guidelines for each TDM-equipped Pro Tools system. Install your cards in your Macintosh in the following order, starting with the lowest numeric slot:

* The guidelines below may include optional cards not present in your system.

Card order for Pro Tools 24 MIX and MIXplus:
1. MIX Core cards
2. MIX Farm cards
3. MIX I/O cards
4. SampleCell II TDM cards
5. SCSI accelerator cards
6. Video capture cards
7. Display card for your computer monitor

Card order for Pro Tools 24:
1. Pro Tools d24 audio cards
2. DSP Farm cards
3. MIX I/O cards
4. SampleCell II TDM cards
Card order for a Pro Tools 24 system that has been upgraded to a Pro Tools 24 MIX system:
1. MIX core card
2. d24 audio cards
3. DSP Farm cards
4. MIX I/O cards
5. SampleCell II TDM cards
6. SCSI accelerator cards
7. Video capture cards
8. Display card for your computer monitor

Card order for Pro Tools III:
1. Video capture cards or SCSI accelerator cards
2. Disk I/O cards
3. DSP Farm cards
4. SampleCell II TDM cards
5. Display card for your computer monitor

Additional Rules for Card Placement

For all Pro Tools systems:
- In systems with more than one card of the same type, install the same card type together in successive slots.
- When combining cards of different types, they should be installed in the following order:
  1. MIX Core cards
  2. MIX Farm cards
  3. d24 cards
  4. DSP Farm cards
  5. SampleCell II cards
- Do not install non-TDM cards or leave empty slots in between TDM-equipped cards.

For 6-slot computers with SCSI Accelerators:
- If you are using a Pro Tools 24 MIX or Pro Tools 24 system in a 6-slot Macintosh with a SCSI accelerator card or a video capture card, the MIX card or d24 audio card must go in one of the first (top) three PCI slots. The SCSI accelerator or video capture card must go in one of the last (bottom) three PCI slots. It is essential that Pro Tools cards and any SCSI accelerator or video capture cards reside in different banks of PCI slots in 6-slot Macintoshes.

For Systems Using an Expansion Chassis:

If you are using an Expansion Chassis, refer to the Pro Tools Expanded System Guide included with your Pro Tools system for instructions on connecting an Expansion Chassis to your computer.

▲ While SCSI accelerator cards are required for Pro Tools 24 and Pro Tools 24 MIX systems on G3 computers, they are not supported for these Pro Tools systems on 3-slot, non-G3 Macintosh computers.
Calibrating the 888/24 I/O

Before you use the 888/24 I/O Audio Interface, you may want to calibrate its input and output levels to the level of your mixing console.

The 888/24 I/O is factory-calibrated so that its input operating level is set to +4 dB nominal with 18 dB headroom nominal at full code, unity gain, making calibration unnecessary for most professional applications.

If you do need to recalibrate your interface or other components of your studio, you can use the alignment procedure described here.

About Calibration

Calibrating levels on a digital recording device is different from calibrating levels on an analog recording device. Unlike analog devices, most digital devices do not have a standard “0 VU” level setting that corresponds to nominal input and output levels. Instead, with an interface such as the 888/24 I/O, the meters are calibrated in decibels below peak (digital clipping) level.

Headroom

The concept of headroom is slightly different for analog and digital devices.

**Analog** Most analog devices allow for a certain amount of headroom above 0 VU. If you send a signal above 0 VU to an analog recorder, you still have a margin of headroom, and if tape saturation occurs, it does so fairly gracefully, giving the audio a compressed sound that some find desirable.

**Digital** Digital devices, on the other hand, do not allow for signals that exceed the dynamic range of the input. When a signal exceeds the maximum input level for a digital device, clipping occurs, causing digital distortion, which is harsh and usually undesirable.

The AES Standard for Headroom

The AES (Audio Engineering Society) standard for headroom is currently –18 dB for nominal level in a digital audio system. The exact value you use will be determined by the amount of headroom available in the rest of your system. For example, if your mixing console has 15 dB of headroom above nominal level, then you may want to calibrate the 888/24 I/O to have 15 dB of headroom.
The Calibration Process

**Analog** To calibrate the input level of an analog device to a mixing console’s output level, you would typically send a 1 kHz tone at 0 VU from the console to the analog deck and align the recording deck’s meters to read 0 VU.

**Digital** With a digital recording device such as the 888/24 I/O, however, in order to allow for headroom, you must align a 0 VU tone from the console to a value less than zero on the 888/24 I/O, by exactly the amount of headroom that you want.

For example, to have 12 dB of headroom above 0 VU with the 888/24 I/O, you must align the incoming 0 VU 1kHz tone to a level of –12 dB. For 18 dB of headroom, you would align it to –18 dB. (Since it is assumed that you are using the 888/24 I/O with a +4 dBu console, a 0 VU signal level coming out of the console is actually equivalent to a nominal +4 dBu level signal.)

Calibrating The 888/24 I/O

To calibrate the 888/24 I/O you will put Pro Tools software in a special operating mode called *calibration mode*, then use the Signal Generator Plug-In to generate a test tone for alignment.

The Pro Tools Installer includes several pre-configured calibration session templates that cover most common calibration setups. You can use these in addition to the calibration procedure given below.

⚠️ Turn down your monitoring system before beginning calibration! The Signal Generator Plug-In emits a continuous signal when inserted on a track.

* During calibration, set all Pro Tools track faders to their default of 0 dB by Option-Shift-clicking (Macintosh) or Alt-Shift-clicking (Windows) on any fader in the session.

To calibrate the 888/24 I/O:

1. In Pro Tools, choose Setups > Preferences and click Operations.
2. Under Output Options, select Direct Outputs.
3. Enter the desired Calibration Reference Level value in dB. A level of –18 dB is typical. (It isn’t necessary to type a minus sign here.)
4. Click Done.
5. Create a new audio track and insert the Signal Generator Plug-In on the track.
6. Set Signal Generator’s output level. This should be the same value you entered as the Calibration Reference Level in step 3.
7. Set Signal Generator’s frequency to 1000 Hz.
8. Set Signal Generator’s signal waveform to Sine.
9. Route the track’s output to Bus 1.
10. Create a mono auxiliary input track for each 888/24 I/O output you want to calibrate. Set the output assignment for each of these auxiliary inputs to its respective 888/24 I/O output.
11. Set the input of each auxiliary input track to Bus 1.
Create an additional mono auxiliary input track for each 888/24 I/O input you want to calibrate. Set the input assignment for each of these auxiliary inputs to its respective 888/24 I/O input. Then set the output of each of these auxiliary inputs to an unused bus pair (for example bus 31–32) so that feedback doesn’t occur when monitoring main outputs 1–2.

Connect an external VU meter to each of the 888/24 I/O outputs in turn. (One at a time as you calibrate.)

Adjust the 888/24 I/O output level trim pots with a Phillips screwdriver to align the outputs to read “0 VU” on the external VU meter.

Connect each output of the 888/24 I/O directly to its input: Connect channel 1 output to channel 1 input, and so on for each channel.

In Pro Tools, choose Operations > Calibration Mode.

The names of all uncalibrated tracks begin to flash. In addition, the track volume indicator of each auxiliary input track receiving an external input signal now displays the reference level coming from the calibrated output.

Adjust the 888/24 I/O input level trim pots with a Phillips screwdriver to align the inputs to match the reference level. When the level is properly matched, the track name will stop flashing.

The Automatch indicator arrows on each track show the direction of adjustment required for alignment:

- When the incoming level is higher than the reference level, the down arrow will appear lit (blue). In this case, trim the 888/24 I/O input level down.
- When the incoming level is lower than the reference level the up arrow will appear lit (red). In this case, trim the 888/24 I/O input level up.

When you have properly aligned the incoming peak signal levels to match the calibration reference level, both Automatch indicator arrows will light: the up arrow red and the down arrow blue.

When you have finished, choose Operations > Calibration Mode again to deselect Calibration Mode.

### Calibrating a System With Both 888/24 I/O and 882/20 I/O Audio Interfaces

The 888/24 I/O is factory preset with 18 dB of headroom in its +4 dB line level operating mode. The 882/20 I/O, however, is fixed at 14 dB of headroom and its inputs are not adjustable.

When setting up an 882/20 I/O (particularly in systems using a combination of the 882/20 I/O and 888/24 I/O), make sure that you use a headroom setting of –14 dB for your system. This helps ensure that recorded audio files have the same relative levels regardless of which interface they are recorded with.
Tuning Up Hard Drives

Because Pro Tools is a disk-based system, keeping your hard drives in good operating condition is essential.

Avoiding File Fragmentation

For maximum recording and playback efficiency, data should be written to your hard drive in a contiguous fashion—minimizing the seek requirements to play back the data. Unfortunately, your computer can't always store the sound files in this way and must write to disk wherever it can find space.

In multitrack recording, audio tracks are written in discrete files, spaced evenly across the disk. While fragmentation of individual files may be zero, the tracks may be far enough apart that playback will still be very seek-intensive. Also, the remaining free space on the disk will be discontiguous, increasing the likelihood of file fragmentation on subsequent record passes.

Increased fragmentation increases the chance of disk errors, which can interfere with playback of audio, and result in stuttering playback of audio files.

Optimizing Drives

To prevent this from happening you can optimize your drive, which rearranges your files into a contiguous format. Most optimizing software lets you run a check on a drive to find out the percentage of fragmentation. If your drive shows moderate to heavy fragmentation, you should consider optimizing it.

If you use your system for intensive editing, or if you frequently delete audio or fade files from your hard drive, you may need to optimize your drives on a weekly basis, or even every few days, since it doesn’t take long for even a large hard disk to become fragmented.

Backing Up Data Before Optimizing

Since your files will be rewritten by the optimization process, always make a backup copy of the data on your hard drive before you optimize it. You should also use a hard disk utility to find and repair any problems before optimizing data. If there is any damage to your hard drive's directories prior to optimizing, serious data loss may result.

Windows NT includes a data backup utility (“Backup”) that allows you to archive data on commonly-used digital data tape devices such as 4mm DDS, DLT, and Exabyte.
CD recorders and DVD-RAM recorders also provide a convenient and reliable way to permanently archive audio files.

⚠️ Before optimizing or defragmenting a hard disk on a Pro Tools III system, remove it from the Disk I/O SCSI bus and connect it to the Macintosh SCSI bus. Always back up important data before defragmenting the disk.

* Windows NT does not have a built-in disk defragmenting/optimizing utility. You must purchase a hard drive maintenance utility such as Norton Utilities in order to do this.

### Formatting Drives

There’s more to hard drive maintenance than just optimization. In order for a hard drive to locate and rearrange its files, its directories must also be intact and in good condition.

When we refer to formatting a drive, we are really speaking of two different types of formatting: high-level formatting and low-level formatting. Here is how they differ:

#### Low-Level (Physical) Formatting

Low-level formatting means completely erasing the hard drive and rewriting each sector address on the drive. In low-level formatting, the sector and track addresses, error-correction codes, and other details are written on the platters of the hard drive in the form of a magnetic pattern. A low-level format permanently erases all data on the drive.

#### When is Low-Level Formatting Necessary?

Virtually all hard drives come pre-formatted from the manufacturer. Low-level formatting is generally unnecessary except in rare circumstances. They are:

- If you wish to change the Block Size of the drive. This is not recommended by Digidesign. Digidesign systems only recognize 512-byte blocks.
- If you wish to perform permanent deletion of data.
- If you wish to clean a drive that is being migrated from one operating system to another (for instance, from UNIX to Macintosh).

Should you decide low-level formatting is necessary, keep in mind that it can take up to three hours or more (depending on the size of the drive). Avoid power interruptions and computer bus resets during the format operation or permanent damage to the drive could occur. In addition, leave the drive powered on for at least 30 minutes prior to formatting so that the drive has time to make any necessary thermal adjustments or recalibrations.

#### High-Level Formatting (Initialization)

High-level formatting, or initializing a drive replaces the drive’s directory, volume partition map and drivers. Information about the drive is created and drivers that communicate this information to the host CPU are installed. The drive itself is not erased, nor is verification performed.
When is High-Level Formatting Necessary?

It is generally necessary to initialize a hard drive in one of the following cases:

- If a new drive is being prepared for use on a computer for the first time and the drive is not already initialized.
- If a drive is being changed from one platform to another. For example if you are switching from a Windows to a Macintosh-based system, the drive must be reinitialized for the new operating system.
- If you suspect that the directories containing the drive’s information have become corrupted.

Partitioning Drives

Partitioning divides a physical drive into multiple, unique volumes, almost as if you were creating virtual hard drives. Partitioning is usually performed when the drive is initialized.

Mac OS 7.6.1 and above allows drives larger than 4096 MB to be seen as whole volumes. Drives must be initialized with a utility that recognizes the 2 terabyte limit. Single files cannot exceed 2048 MB in size.

Seek Times on Partitioned Drives

Seek times are actually faster on partitioned drives (assuming that reads and writes are performed on a single partition), since the heads only have to seek within the partition boundaries, rather than the whole capacity of the drive.

In addition, smaller partitions perform faster than larger partitions. However, this comes at the expense of contiguous storage space. When you partition a drive, you will need to find the compromise that best suits your performance and storage requirements.

Avoid distributing audio files within a session over different partitions on the same drive since this will adversely affect drive performance.

Using Iomega Jaz Drives

Iomega Jaz drives provide up to 8-track recording and playback of 16-bit audio files per drive.

To use a Jaz drive:

1. Prepare the Jaz Cartridge.

Before using the Jaz drive with Pro Tools, the cartridges must be initialized for use with the Macintosh. Initialization must be performed using Iomega’s Jaz Tools while the Jaz drive is connected to the Macintosh SCSI bus. Before initializing a cartridge, select the Verify Disk Writes option in the Iomega Drive Options dialog.

This option provides additional data protection by ensuring that all data written to disk is done so correctly as the data is written. Digidesign recommends that you do this in order to provide the highest data integrity. (The Iomega Jaz Tools are included with the Jaz Drive or they can be downloaded from Iomega’s web site: www.iomega.com.)

With the Verify Disk Writes option enabled, Jaz drives can be used with Pro Tools systems to record and play back up to 8
tracks, depending on the capabilities of your Pro Tools system. Digidesign does not recommend disabling the Verify Disk Writes option since data integrity may be compromised.

2 Connect the Jaz Drive to your Pro Tools system.

Once the Jaz cartridge has been initialized, connect the Jaz drive to your system. For Pro Tools 24 MIX or Pro Tools 24 systems, connect it to your Macintosh SCSI bus or SCSI accelerator card. For Pro Tools III systems, connect it to your Disk I/O card.

3 Mount the Jaz Cartridge.

With the Jaz drive attached to the your system's SCSI bus, cartridges may be inserted and spun up prior to starting your Macintosh, or they may be inserted afterwards.

On Pro Tools III systems, if a Jaz cartridge is not inserted and spun up prior to starting your Macintosh, and there are no other active SCSI devices on the Pro Tools SCSI bus, the DigiSystem INIT will indicate a “No Drive” error. Simply wait for the computer to finish starting up, then insert a cartridge. Once the cartridge has spun up, it will appear on the desktop and be ready for use.

### Enabling Fast SCSI Transfers With Jaz Drives

**Pro Tools III Systems Only**

If you have a Pro Tools III system, Digidesign recommends using the Jaz drive with the Fast SCSI transfers option enabled in the Mt. Digi utility.

### To enable Fast SCSI transfer:

1. From the Apple Menu, select Control Panels and select Mt. Digi from the submenu.
2. When Mt. Digi appears, select the Enable Fast SCSI option.
3. Restart your computer with a Jaz cartridge installed and spun up for these changes to take effect. Once fast transfers are enabled on the Jaz drive, it will remain in fast mode (even if you exchange cartridges) until you shut down, or restart without a cartridge inserted.

### Sleep Mode

Jaz drives utilize a sleep timer to spin down cartridges after a period of inactivity in order to minimize wear. The default inactivity period is 30 minutes. Pro Tools maintains this time period and allows Jaz to spin down cartridges without affecting activity on the Pro Tools SCSI bus.

Jaz users wishing to play back from or record to a Jaz drive which is asleep will experience up to a 15 second delay as the cartridge spins up. Once the cartridge is ready, normal playback or record operations will begin.

### Cartridge Ejection

In order to minimize restart times, Pro Tools will not automatically eject cartridges at restart or shutdown. To eject a Jaz cartridge after use, simply drag the cartridge icon to the Trash.
Never eject cartridges while Pro Tools is running or serious data loss could occur. Always quit the Pro Tools application before ejecting cartridges.

**Cartridge Care**

To ensure the longevity of your Jaz cartridges, follow the manufacturer’s procedures for care and handling. Do not store cartridges on or near audio monitors or data loss may result. We recommend that you periodically reformat and reinitialize Jaz cartridges in order to maintain the highest possible performance and data integrity.
Numerics

1-2 Format 27
1622 I/O Audio Interface 11
   as stand-alone converter 45
   back panel 42
   connecting to studio 43
   connections & levels 4
   front panel 40
   input meters 41
   output meters 41
16-channel peripheral cable adapter 13
44.1 kHz 27, 35, 41
48 kHz 27, 35, 41
50-pin Interface Connector 29, 37
60-pin Interface Connector 43
882/20 I/O Audio Interface 11, 34
   +4dBu mode 32, 38
   -10dBV mode 38
   as stand-alone converter 39
   back panel 36
   connecting to studio 38
   connections & levels 4
   front panel 34
888/24 I/O Audio Interface 11
   as stand-alone converter 33
   back panel 28
   changing operating levels 30
   connecting to studio 26
   connections & levels 4
   front panel 26

A

ADAT Bridge I/O
   connections & levels 4
Adjusting Scan Times
   on Pro Tools SCSI bus 24
AES/EBU 29, 54
Analog audio

B

backing up data 63

C

cable length of SCSI drives 17
Calibrating the 888/24 I/O 28, 60
Calibration Mode 28
Card order 57
   Pro Tools 24 57, 58
   Pro Tools III 58
Ch 1-2 Input 35, 41
clipping 59
clock master 11
Compatibility Information for Pro Tools 4
Configuring Expanded Pro Tools systems 51
Configuring Pro Tools 53
Connecting
   Digital Recorders 46
   Effects Units 46
   external SCSI drive 18
   SMPTE Synchronization Devices 48
   studio 25
CPU requirements 1

D

d24 card 6
DAC Muting option
   Hardware Setup dialog 54
DAT recorder 54
   connecting to Pro Tools 46
DC Offset 54
Demo Session 51
   installing 52
   playing 54
DigiSerial port 6
   digital distortion 59
Digital Sync mode 26
DigiTest 51, 57
   direct outputs mode 25
Disk Administrator 17
   using to partition and format drives 20
Disk I/O 7, 24
disk signature 20
DSP Farm 7

E
   Effects units
      connecting to Pro Tools 46
   EIDE drives 3
Expanded Pro Tools Systems
   configuring 51
   expanded systems and IDE drives 3
Expansion Chassis 5
   using with Pro Tools 58

F
   Fast SCSI Transfer Mode
      activating 23
   FAT file system 16
   Formatting hard drives 16, 64
      high-level 64
      low-level 64
   Fragmentation 63

G
   G3 computer requirements 3

H
   Hard Disk ToolKit™ PE 16
   hard drive requirements 2
   Hard drives
      larger than 4 gigabytes 17
      mounting 24
      optimizing 63

Hardware Setup dialog
   configuring Pro Tools with 53
      DAC Muting option 54
Headroom 59
HFS Drives
   formatting 23
   mounting 22
   High-level formatting 65
I
   input gain levels
      setting 43
Input Level Trims 28
Input Meters of 1622 I/O 41
Installer CD 52
Installing
   Demo Session 52
   Pro Tools cards 8, 9
   software 5
Install-O-Rator 5
   Intel PIIX IDE driver 3
   Internal Sync mode 26
   Iomega Jaz drives 65
      Cartridge Care 67
      cartridge ejection 66
      sleep mode 66
      with Fast SCSI 66

J
   Jaz drives 65

L
   Level Meters 27
   Low-level formatting 64

M
   Macintosh G3 computer requirements 3
   Macintosh hard drives, using 22
   Macintosh sessions, playing 22
   MacOpener 22
   Maximum partition size 21
   MIDI
      connections 47
   MIDI requirements 3
   MIX Core Card 6
   MIX Farm Card 6

70 Pro Tools TDM Hardware Installation Guide
Mount button 24
Mt. Digi
  Control Panel 24
  mounting hard drives 24

N
Norton Utilities 64

O
Operating levels
  changing on 888/24 I/O 30
Optimizing hard drives 63
Other Options dialog 54
output gain levels
  setting 44
Output level
  trims 28
Output Meters of 1622 I/O 41
output mode
  choosing 54

P
Partitioning
  hard drives 65
  maximum size 21
Power Input 30, 37, 43
Power Macintosh G3 computers 16
Power switch 40
Pro Tools 24
  installing system hardware 6
  system capabilities 1
Pro Tools 24 MIX
  installing system hardware 5
  system capabilities 1
Pro Tools III
  core system hardware 7
  system capabilities 1
Pro Tools SoundCheck session 52

R
Recalibrate Inputs button 54

S
S/PDIF 54
  digital input/output 29, 37, 43
Sampling rates 27, 35, 41
SCSI accelerator cards 17, 58
SCSI bus
  internal and external 16
  types 16
SCSI cable length 17
SCSI termination 19
seek times of hard drives 65
setting input gain level 43
setting output gain levels 43
Signal Connections 43
  to 888/24 I/O 32
Signal Generator Plug-In 28
Signal Present LEDs 35
signal-to-noise performance 43
Slave 34, 40
Slave Clock In/Out 29, 36, 42
  ports 12
Slave Sync mode 26
Sleep Mode
  and Iomega Jaz drives 66
Slot Order On Macintosh Computers 57
Stand-Alone mode
  1622 I/O Audio Interface 45
  882/20 I/O Audio Interface 39
  888/24 I/O Audio Interface 33
stereo mix outputs mode 25
Studio configuration
  with mixer connections 38, 44
  without a mixer 38, 44
studio setup
  with 1622 I/O 44
  with 882/20 I/O 38
  with 888/24 I/O 32
Super Clock signal 29
Sync Mode 34, 40
  LEDs 26
Synchronous Transfer Mode 23
system requirements 1

T
Tascam DA30 DAT recorder 54
TDM Ribbon Cable 7
Termination of SCSI drives 19

U
Universal Slave Driver 49
Wiring scheme of 888/24 I/O 32